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 :مقدمه 
يكي از بزرگترين مشكلات موجود در تحقيق انتخاب روش آمـاري صـحيح بـراي تجزيـه و تحليـل      

بينيم كه به روش آماري نادرست مورد ارزيـابي قـرار    عات مختلفي را ميلامروزه مطا. باشد ها مي داده

 .است شده دادهران قرار به اشتباه در اختيار ديگاز آنها و نتايج حاصل گرفته 

نـرم افزارهـاي   . كندها كمك  ن را در تفسير درست دادهيتواند محقق انتخاب روش آماري صحيح مي

ايـن نـرم    ولـي ، گذارنـد  ش ميو تحليل اطلاعات را در زمان كوتاهي به نماي هآماري به راحتي تجزي

بايد با دانش خود روش آماري محقق  .توانند روش صحيح آماري را به محقق نشان دهند زارها نمياف

 .را اجرا كند هانرم افزارها آن اين صحيح را انتخاب نمايد و به كمك

باشد، اين مفهوم در زبـان انگليسـي    مفهوم تحقيق از زبان عربي است و به معني مطالعه حقيقت مي

تحقيـق را يـك تـلاش    . اسـت جستجو و بازرسي دقيـق   معنيكه به  است Research تحت عنوان

اد يك منبع جدانند كه در نهايت به اي هاي موجود مي ديد و يا اصلاح دادهجظم براي توليد دانش من

 .شود غني علمي در هر رشته و حرفه منجر مي

هـا و   دانش مربوط به فرايندهاي مراقبـت از بيمـاري   ،كند با تحقيق يك محقق در علوم پزشكي سعي مي

جديد درماني را مورد پژوهش قرار دهد تا بدينوسيله هم درك هاي  تا دستيابي به روش ،نحوه درمان آنها

هاي جديد در پيشگيري، ارتقاي سلامت و درمـان   را افزايش دهد و هم روش افراد و متخصصين مربوطه

اً ي مـوارد را  ربراي رسيدن به اين هدف از ابتداي تحقيق بايد يك س ـ محقق نمايد،ها  ارائه  بيماري  دقيقـ

متاسفانه امـروزه كارهـاي   . خواهد صرف كند به هدر ندهد كه مي را اي خود و بودجهتا وقت نمود رعايت 

مجدد ندارند و در نهايت ايـن   انجامگيرد كه بيشتر آنها نيازي به  تكراري زيادي در سطح علمي انجام مي

 شـدن ايـن  نچـاپ  علت اصـلي   ،گيرد شود مورد پذيرش قرار نمي گونه موارد كه به توليد علمي منجر مي

پـس در  . ردباشد كه نيازي به تحقيـق مجـدد نـدا    تكرار يك اصل علمي و ثابت شده مي به خاطر مقالات

نوآوري به مفهوم اين نيست كه كارهاي انجـام  . همان ابتداي تحقيق بايد ويژگي نوآوري را در نظر گرفت
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رضه عويرايش و  ،ي جديديم و آنها را با استفاده از منابع علميسازمان دهي نماو  آوري شده قبلي را جمع

باشـد، محقـق بـر اسـاس      يك مشكل مـي حل بلكه نوآوري به مفهوم ارائه يك انديشه جديد براي  ،كنيم

نمايد تا به سئوال تحقيق پاسخ  ها مي آوري داده شواهد لازم به طور مستقيم و غير مستقيم اقدام به جمع

 ،بـا آزمـون آنهـا در شـرايط واقعـي     محقق و  هاي عيني باشد ها بايد بر اساس روش آوري داده جمع. دهد

هـاي حاصـل    داف تحقيـق تعمـيم دادن داده  ه ـيكي ديگر از ا. ايدنممي ها را رد و يا قبول  صحت فرضيه

بـر اسـاس اصـول علمـي بـه      را بدست آمـده  تواند نتايج  يك گروه كوچك ميبررسي محقق با . باشد مي

كه در نهايـت بتـوان    شودطراحي به صورتي مان ابتدا پس تحقيق بايد از ه. هاي بزرگتر تعميم دهد گروه

 . به اين مهم دست يافت
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 راهنماي گام به گام در تحقيق: فصل اول 
 شروع تحقيق

كه در ذهن محقـق بـه صـورت يـك      گردد، احساس وجود يك مشكل آغاز ميشروع يك تحقيق با 

تن حمايت مـالي و معنـوي   سعي در گرف ،و محقق با بيان آن به صورت علمي شود ميسئوال مطرح 

محقـق بايـد مشـكل     ،بـراي شـروع  . واب مورد نظر دست يابدجهاي ذيربط دارد تا بتواند به  دستگاه

در نوشتن ايـن طـرح رعايـت     .قالب يك طرح تحقيقاتي به محل مورد نظر ارائه نمايد مربوطه را در

 . استيك سري نكات ضروري 

 

 

 

 

 

 

 

 

 

 انواع تحقيق -1

لازم اسـت محقـق در    ،كنند دو دسته كاربردي و بنيادي دسته بندي مي بهيقات را به طور كلي تحق

تـوان هـر دو نـوع تحقيـق      همان ابتدا نوع آن را مشخص نمايد هر چند در برخي از تحقيقـات مـي  

 .را ذكر نمود )كاربردي و بنيادي(

 شروع تحقيق

 احساس وجود يك مشكل

 نوع تحقيق را مشخص كنيد

 بنيادي  كاربردي
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 تحقيق بنيادي-1-1

دهـد و كـاربردي از آنهـا مـدنظر      مي افزايش را بشريدر حقيقت بار گنجينه دانش  اين نوع تحقيق

هـاي   نيست مثلا بررسي بر روي افـزايش يـك پـروتئين در بيمـاران ميگرنـي و يـا بررسـي واسـطه        

تـوان   را مـي  ،ي در افزايش درديي در فرآيند خواب و يا مشخص نمودن فاكتورهاي بيوشيميايشيميا

 . نام برد

 تحقيق كاربردي -2-1
در اين نوع تحقيق . باشد ل مدنظر ميضيني و يا كنترل يك معدر اين روش حل يك مشكل، پيش ب

دانش جديدي را كه در نتيجه تحقيقات بنيادي فراهم شده است از نظر كاربرد عملي مورد بررسـي  

باشد كه بر اساس صـدها تحقيـق بـر     ترين مثال آنها همانند سازي در بزغاله مي ساده. دنده قرار مي

تـوان پايـان كـار يـك سـري از       تحقيـق كـاربردي را مـي   . فته اسـت روي سلولهاي بنيادي انجام گر

تواند منجر به شروع يـك سـري تحقيقـات بنيـادي      تحقيقات بنيادي دانست كه به خودي خود مي

آوري  بندي ديگر براي تحقيقات وجود دارد كه براساس نوع و روش جمـع  يك نوع دسته. ديد شودج

 .كنند بندي مي ي و تحقيقات كيفي دستهآنها را به دو گروه تحقيقات كم ،ها داده

 

 

 

 

 

 

 

 

 شروع تحقيق

احساس وجود يك 
 مشكل

مشخص كردن نوع 
 تحقيق

 بنيادي  كاربردي

 تحقيقات كيفي 
 به كتب مربوطه مراجعه كنيد

 تحقيقات كيفي تحقيقات كمي 
 به كتب مربوطه مراجعه كنيد 

 تحقيقات كمي 
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 تحقيق كيفي -3-1
به سرعت دارد جاي خود را در ميـان محققـين بـاز     اما استدر كشور ما بسيار نوپا  تحقيقنوع اين 

رود كه قابل تبديل  ي به كار مييها باشد كه براي بررسي پديده يك روش منظم و ذهني مي كند، مي

ها  اين نوع تحقيق به منظور درك و توصيف تجارب انساني، برداشت.يستند به كميت و عدد و رقم ن

 ،نجا كه اين احساسات و تجربيات قابل تبديل به كميت نيسـتند آاز . گيرد و احساسات فرد انجام مي

امـروزه از  . هـا بدسـت آورد   تري را نسبت بـه ايـن پديـده    تر و جامع توان درك كامل با اين روش مي

لاً . شود ي استفاده مييموزش بهداشت، پرستاري و ماماآهاي روانشناسي،  رشتهتحقيق كيفي در   مـث

0Fنامه دكترا مربوط به سركار خانم زماني پايان

علل عدم استفاده از كلاه ايمنـي و مقـررات   «در مورد  1

محقق بر اساس اين نـوع تحقيـق   . باشد از اين نوع تحقيق مي »ي و رانندگي در موتورسوارانيراهنما

نامـه   پايـان مثـال ديگـر    تواند يك پرسشنامه استاندارد را در يك موضوع پزشـكي طراحـي كنـد    مي

منجر به توليد علمي پرسشنامه استاندارد كيفيـت زنـدگي در   كه  است خانم دكتر مسعودي دكتري

 .بيماران ديابتيك گرديد

كـدام روش  بايـد تصـميم بگيـرد كـه مطالعـه خـود را بـر اسـاس          ،قبل از شروع به كارپس محقق 

  .خواهد انجام بدهد مي

 تحقيقات كمي -4-1

اين نوع تحقيق يك روش . اكثر تحقيقات انجام شده در علوم پزشكي از اين نوع تحقيقات مي باشند

گيري و رابطه علـت و   منظم و عيني براي جمع آوري اطلاعات است، كه متغيرهاي مختلف را اندازه

بر اساس نتايج بدست آمده اقدام به توصيف مشكل مربوطـه   نمايند، و معلولي را در آنها مشخص مي

اين روش براي پاسخ به سئوالات مربوط به . نمايند هاي پيشنهادي جديد را ارائه مي راه حلو نموده 

 .بهداشت، سلامتي و بيماري مناسب است

                                               
 گروه آموزش بهداشت -دانشكده پزشكي – 88و  82پايان نامه دكتري تربيت مدرس سال   1
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 مي كنيممطالعات كمي را به دو گروه مطالعات غير تجربي و مطالعات تجربي دسته بندي 

اين مطالعات را به سه گروه مطالعات توصيفي، مطالعات كوهورت و  :مطالعات غيرتجربي -1-4-1

 .شوند مطالعات مورد شاهدي تقسيم مي

 

 

 

 

 

 

 مطالعات توصيفي -1-1-4-1

در مطالعـات تحليلـي    ،توان فرضيه يا فرضـياتي را بدسـت آورد كـه از آنهـا     از اين نوع مطالعات مي

كند اين فرضيه يـا   محقق با بررسي در رابطه با يك بيماري يا يك پديده سعي مي. نيمك مياستفاده 

. ه اسـت بـود در قرن گذشته مهمترين اين نـوع مطالعـات مربـوط بـه ايـدز       .فرضيات را بدست آورد

سترش اين بيماري در بين معتادان تزريقي و افراد هم جنس بـاز  گمطالعات توصيفي اوليه حاكي از 

 شروع تحقيق

 نوع تحقيق را مشخص كنيد

 بنيادي ، كاربردي 

 مطالعات كمي 

 مطالعات غير تجربي  مطالعات تجربي 

 تحقيقات بنيادي يا 
 كاربردي 

 غير تجربي

 توصيفي كوهورت شاهدي –مورد 
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. يابـد  هاي خوني نيـز گسـترش مـي    وردهآعات بعدي نشان داد كه اين بيماري از طريق فرو مطال بود

كنند كه بارها در  بيشتر محققين به خاطر آسان بودن مطالعات توصيفي اقدام به تكرار مطالعاتي مي

امروزه بـا مراجعـه بـه     .باشد سطح جامعه انجام گرفته است و ديگر نيازي به بررسي مجدد آنان نمي

ويان يا جتوانيم مطالعات زيادي را در مورد آگاهي و نگرش پرستاران يا دانش لات علمي داخل ميمج

اولـين مطالعـه در    بايد دقت نمود كه مطالعات توصيفي معمولاً. در مورد يك مسئله بدست آوريم... 

 اتمطالع ـ ن درنتايج آبدون استفاده از اين مطالعات باشند و تكرار  رابطه با يك بيماري يا پديده مي

 . گردد اتلاف منابع مالي و انساني ميباعث 

توان به صورت مقطعي،  ات را ميعاي هستند اين مطال لهخغير مدااز نوع مطالعات مطالعات توصيفي 

به طور مثال مطالعه بر روي ميزان كنتـرل قنـد خـون بيمـاران     . نگر انجام داد ينده نگر و يا گذشتهآ

يـك مطالعـه    ،انجـام گيـرد   HbA1Cبررسـي  اگر به صورت يـك بـار    ،ديابتيك و نحوه كنترل آن

ي مدت شـش مـاه دنبـال كنـيم و در چنـد مرحلـه ميـزان        طو اگر اين بيماران را در است مقطعي 

HbA1C، باشد و اگر مطالعه ما بـر اسـاس بررسـي     مي نگر يندهاز نوع آ را كنترل كنيم اين مطالعه

از نـوع  ايـن مطالعـه    ،باشـد آنان هاي پرونده  ما بر اساس يافته پرونده بيماران انجام گيرد و اطلاعات

در درون مطالعـه   يمتوان ما فاقد گروه مقايسه هستيم ولي ميتوصيفي در مطالعات  .استنگر  گذشته

مـثلا يـك مطالعـه توصـيفي در مـورد كنتـرل قنـد در        . يمينماخود مورد نظر هاي  همقايساقدام به 

به سـه  )  HbA1Cميزان( بيماران را بر حسب نوع كنترل آنها وه است بيماران ديابتيك انجام گرفت

د را بـر  آماري خوهاي  هبندي و مقايس ، كنترل بينابيني و كنترل ضعيف دستهگروه با كنترل مطلوب

 .دهيممي همين اساس انجام 

  مطالعات كوهورت -2-1-4-1

مطالعـات   محقق در اين نـوع . گردد نگر اجرا مي كه به صورت آينده است اي يك مطالعه غير مداخله

سـير يـك    مثلاً .نمايد مي زماني طولانييك دوره در ) مانند يك بيماري(اقدام به بررسي يك عامل 
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اي داشـته   دهد بدون اينكـه در آن مداخلـه   مورد بررسي قرار ميمشخص جمعيت يك بيماري را در 

گروهـي كـه در معـرض عامـل      .دكن در حقيقت جمعيت مورد بررسي را در دو گروه دنبال مي .باشد

باشند و گروهي كه در معرض اين عامـل نيسـتند ايـن دو گـروه در طـول زمـان پيگيـري         خطر مي

بـا  . شـوند  شود و با يكديگر مقايسـه مـي   شوند و ميزان بروز و يا موارد ديگر در آنان سنجيده مي مي

ق بـيش از يـك نـوع بيمـاري را     محق باشند معمولاً توجه به اينكه اين نوع مطالعات گران قيمت مي

پيگيري افراد سيگاري از نظـر سـكته    باشند مثلاً كند كه با يك عامل خاص در ارتباط مي دنبال مي

 . گيرد ميانجام  بي و سكته مغزي بطور همزمانلق

كسي در معرض خطـر قـرار   ) ييمانند مداخلات دارو(در مطالعات كوهورت به علت نداشتن مداخله 

در ايـن  . كنـد  نوع مطالعات به خوبي ميزان خطر مطلق يك بيماري را مشخص مـي  گيرد و اين نمي

توان مشخص نمود چون مطالعـه از   بخوبي رابطه علي بين عامل خطر و بيماري را مي ،نوع مطالعات

از مزايـاي ديگـر ايـن مطالعـات     . اسـت  عامل خطر شروع شده و اين عامل بر بيمـاري داراي تقـدم  

 .استمطالعه و ارزيابي نتايج استاندارد كردن روش 

تـوان پـر هزينـه     با وجود تمام مزاياي فوق اين مطالعات داراي معايبي هستند كه از جمله آنهـا مـي  

 .طولاني بودن مدت زمان بررسي را نام برد وبودن 

 

 مطالعات مورد شاهدي -3-1-4-1

ر ايـن نـوع مطالعـات يـك     د .است گيرد از اين نوع بيشترين مطالعاتي كه در علوم پزشكي انجام مي

جز  به در تمام موارد اين دو گروه .گردنند بيمار و گروه ديگر به عنوان شاهد تلقي مي به عنوان گروه

پس از انتخاب گروه بيمار و شاهد بـه بررسـي    تحقيقات،در اين . باشند مشابه مي يكديگربيماري با 

بطـور مثـال   . باشـد  نگـر مـي   گذشـته  ،اتعپردازيم پس اين نوع مطال متغيرهاي مورد نظر در آنها مي

پـس از انتخـاب    .اسـت يك مطالعه مـورد شـاهدي    »ميزان روي سرم در بيماران سرطاني«مطالعه 
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مقدار ايـن  . شود يده ميجو ميزان فلز روي سن شدهاز آنان نمونه خون گرفته  ،بيماران و گروه شاهد

تـر مـا    باشد به عبارت سـاده  تا حال مي متغير در خون هر دو گروه نشان دهنده ميزان آن از گذشته

 . شود نگر محسوب مي به همين علت گذشته ،سنجيم ميزان متغير را تا زمان آزمايش مي

در اين مطالعات . باشند مي...  وزمان كم  كم،هزينه از جمله اين مطالعات داراي مزاياي بيشماري 

ين مطالعات زماني امحدوديت . دنتايج قابل قبولي را بدست آور كوچكتوان با يك نمونه  مي

هاي بيماران عمل كند و يا در زماني كه گروه  گردد كه محقق بخواهد براساس پرونده مشخص مي

انستيتو ان سرطاني را كه به ربيمار متفاوت باشد مثلا فرض كنيد كه ما بيماگروه با  شاهد كاملاً

دهيم و اين گروه از بيماران  قرار مي از لحاظ ميزان روي سرم مورد بررسيكنند  سرطان مراجعه مي

كه انتخاب كنيم افرادي ما همگي جزء افراد كشاورز و يا كارگر باشند و گروه شاهد خود را از بين 

ط يبا توجه به اينكه دو گروه از نظر شرا. اند براي چك آپ به يك مركز خصوصي مراجعه كرده

 .است اريبيباشند نتايج ما داراي  دموگرافيك متفاوت مي

 

اين نوع تحقيقات به صورت مداخلات آموزشي، مداخلات دارويي،  – مطالعات تجربي -2-4-1

 ؟ه شما كدام است طالعنوع م انجام مي گيرد... مطالعات متقاطع و 

 

 

 

 

 

 

 

 تحقيقات بنيادي يا كاربردي در مطالعات كمي 

 تجربيمطالعات 

 مطالعه متقاطع مداخلات آموزشي مداخلات دارويي  ساير مطالعات 
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بيمــاران فشــار خــوني را در دو گــروه  ،فــرض كنيــد محقــق -مــداخلات آموزشــي -1-2-4-1

اعمال مي كنـد و در   وبر اساس يك برنامه آموزشي  را، ه مداخلهكند و براي يك گرو بندي مي دسته

. دهـد  مقايسات بين دو گروه تاثير مداخله آموزشي را نشان مي .دهد گروه ديگر اين كار را انجام نمي

شود ايـن نـوع    تغذيه به فراواني استفاده مي و ، آموزش بهداشتز اين نوع مطالعات در علوم پزشكيا

مطالعـات تجربـي در علـوم    . باشـد  اه اثبات رابطه علي بين متغيرهاي مطالعه ميمطالعات قويترين ر

ي در انتخـاب گـروه شـاهد    يلازم است كه دقت بـالا  ود نباش ي باليني مييپزشكي به صورت كارآزما

تا  (Matching)سازي  انجام گيرد و تا حد امكان دو گروه مشابه يكديگر گردند و همسان) كنترل(

 .گروه شاهد و بيمار انجام گيرد ينب امكان،جاي 

 ييمداخلات دارو -2-2-4-1

برخـي از  . شود پلاسيبو ناميده مي باشد كه اصطلاحاً ي باليني بر اساس دارو نما مياييك نوع كار آزم

آسپيرين بچه به يك گـروه و دادن داروي   كنند كه دادن يك داروي معمولي مثلاً محققين تصور مي

در حاليكه در ساخت دارونما بايـد دقـت    باشد، ميت اصل مطالعات پلاسيبو رعاي ،اصلي به گروه دوم

هـاي مشـابه    نمود كه دارو نما بايد كاملا از نظر ظاهر مشابه با داروي اصلي باشـد و حتـي در بسـته   

اين كار لازم است با نظارت كارخانه سازنده دارو و همكاري بخش تحقيقات انجام  .دنبندي گرد بسته

ست كه بيماران شركت كننده در طرح ممكن است كه با يكـديگر  ا صلي اين مسئله اينعلت ا. گيرد

ان متفاوت است و تغييـرات در بهبـودي يـك بيمـار     نتماس داشته باشند و متوجه شوند داروهاي آ

از نظـر  مطالعـات  از داروي ديگـر اسـتفاده كنـد، از طرفـي ايـن      تواند بيمار ديگر را مشتاق كند  مي

گيـرد و بـراي بيمـار     باشند چون محقق براي يك بيمار درمان را در نظر مي ئوال مياخلاقي مورد س

د ح ـشـود كـه تـا     امروزه توصيه مـي . كند تجويز مي را برد دارونما كه از همان بيماري رنج مي ،ديگر

ممكن از دادن دارو نما پرهيز كنيم و فقط يك گـروه بيمـار داشـته باشـيم و تغييـرات مربـوط بـه        
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تا از نظر اخلاقي  گيرد،مختلف در قبل و بعد از تجويز دارو در بيماران ملاك ارزيابي قرار يرهاي غمت

 .مشكلي بوجود نيايد

 

 

 

 

 

 

توان يـك   اين مطالعات را مي ،با توجه به اينكه دادن دارو نما هنوز در بسياري از مطالعات رواج دارد

سو كور مطالعاتي است كه در آن بيمار از مطالعات يك . سو كور، دو سو كور و سه سوكور انجام داد

مطالعات دو سو كـور  . كند واقعي است يا نه ي كه مصرف مييداند دارو نحوه درمان خبر ندارد و نمي

بي اطلاع باشند  مي گيرداز اينكه بيمار در كدام گروه قرار  ،وضعيتي است كه در آن پزشك و بيمار

بندي بي  گروهاز  نيز را بر عهده داردها  دادهناليز آي كه دفرعلاوه بر پزشك و بيمار، كور و در سه سو

بندي بي اطلاع هستند و تنهـا يـك    از گروهها كليه افراد  در حقيقت تا پايان آناليز داده ،اطلاع است

 .بندي مربوطه اطلاع دارد نفر كه محقق اصلي است از گروه

 

 مطالعات متقاطع -3-2-4-1

به دو گروه مساوي تقسيم مـي شـوند ، نيمـي از بيمـاران دارو نمـا و      بيماران  ،در اين نوع مداخلات

كنـد و اثـرات    كنند سپس به مدت مشخص اين امـر ادامـه پيـدا مـي     نيمي ديگر دارو را دريافت مي

كنيم و يـك   سپس دارو ودارو نما را قطع مي .شود داروي جديد و متغيرهاي مورد لزوم سنجيده مي

 گرفته سپس به گروهي كه دارو نما  .كنيم تا اثرات دارو برطرف شود مدت بسته به نوع دارو صبر مي

 تحقيقات بنيادي يا 
 كاربردي در مطالعات كمي 

 تجربي

 مداخلات دارويي  ساير مطالعات 
 

 مطالعه متقاطع مداخلات آموزشي

رعايت  ايا اخلاق پزشكي را
 كنيد؟ مي

 يك سو كور، دو سو كور و 
 سه سو كور را مشخص كنيد
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ان لازم زم مدت دهيم و مجدداً است دارو نما را مي اند، داروي جديد و به گروهي كه دارو گرفته اند،

پردازيم در اين نوع مطالعـه هـر    سپس به ارزيابي نتايج مي ،طي شودتا گذاريم  را براي تاثير دارو مي

 .ثيري در نتايج بدست آمده ندارندتا ،اشد و عوامل ديگرب كنترل خودش مي ،ه مطالعهفرد گرو

مـي توانـد موضـوع خـود را     اينكه چه نوع مطالعه اي را در نظـر دارد  حقق پس از مشخص نمودن م

  .مشخص كند
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 چگونه يك طرح تحقيقاتي بنويسيم

براساس مـوارد گفتـه شـده در فصـل      براي نوشتن يك طرح تحقيقاتي ابتدا بايد نوع مطالعه خود را

 .تواند راهنماي شما براي انجام اين كار باشد چارت زير مي. قبل مشخص كنيد

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 موضوع -1-2

هـا و   برخي اوقات سـازمان . در تنظيم موضوع بايد طوري عمل نمود كه بيانگر موضوع پژوهش باشد

ح رنمايند و محقق بر اساس آن اقدام به ارائـه ط ـ  ها موضوعات مورد علاقه خود را مشخص مي ارگان

به کتب معتبر در اين 
 زمينه مراجعه کنيد

 

 شروع تحقيق 
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برخـي   .گيـرد  علاقه محقق در راستاي اهداف سازماني قـرار مـي  ، در اين حالت مي نمايدتحقيقاتي 

و سـازمان   نمايـد  مـي اوقات محقق موضوع خود را بر اساس نيازهاي يـك سـازمان طراحـي و ارائـه     

ي داشته ي، به هر حال محقق بايد توانادهد مي رقراحمايت مالي مورد مربوطه بر اساس آن محقق را 

اقدام به حمايت مالي  ،هاي مربوطه باشد تا بر اساس تنظيم موضوع به نحوي عمل نمايد كه سازمان

وع بايد مـوارد  در تنظيم موض. موضوع مورد بحث را در راستاي اهداف خود بدانندو معنوي نموده و 

 :زير را رعايت نمود

قيـق در زمـان متفـاوت و يـا در     حطي كه موضوع مـورد ت ي، البته در شرااشدي بموضوع داراي نوآور

 .نمـود تـوان از تكـراري بـودن آن چشـم پوشـي       مـي  ،دهـد  ميمكان متفاوت نتايج جديدي را ارائه 

كـافي نبـودن نتـايج در تحقيقـات      ،كنـد  مـي  هي ـجاي كه يك موضوع تكراري را تو مهمترين مسئله

 .به خوبي توضيح دهد ،بايد بيان مسئله موضوع را ،قمحق است، در اين حالتگذشته 

محقق بايد در مورد مسئله مورد نظر داراي دانش كافي باشد و صرف احساس يك مشكل دليـل بـر   

وي سـاده در  جسـت جدر بسـياري از مـوارد بـا يـك     . اقدام براي انجام يك طـرح تحقيقـاتي نيسـت   

كـه در  دست پيدا نمود ر مورد موضوع مورد نظر توان به اطلاعات مهمي د هاي اينترنتي مي كتابخانه

 .كدام مرحله علمي قرار دارد

در نوشتن موضوع بايد رابطه علت و معلولي را در نظر گرفت و زمان و مكان مورد نظـر را مشـخص   

كه نوشتن مكان و زمان مورد نظر در نوشتن مقالات مرسـوم نيسـت ولـي در     يديانمود بايد دقت نم

خـودداري   "بررسـي " كلماتي چونبهتر است از ذكر . ع بايد به آن توجه داشتانتخاب عنوان موضو

فرامـوش  . پس از نوشتن موضوع چندين بار آن را باز نويسي كنيد تا به بهترين وضعيت برسيد. شود

 .ايد علني نكنيد نكنيد كه موضوع خود را تا زماني كه آن را تصويب نكرده

ممكـن اسـت    .يا نـه  ان علمي انجام آن براي شما وجود دارددر انتخاب موضوع دقت كنيد كه آيا تو

تحقيق شما نياز به يك وسيله خاص داشته باشد كه در دسترس شما نباشد و يا شـما در حـين   كه 
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بـه هـر حـال محقـق     . حاضر به همكاري نباشدتحقيق به دانش يك متخصص نياز داشته باشيد كه 

را مشخص كند و سپس اقـدام بـه نوشـتن طـرح      پس از تنظيم موضوع بايد موارد قوت و ضعف آن

 .استارزشيابي آن  ،اولين مرحله بعد از انتخاب موضوع. تحقيقاتي مورد نظر نمايد

 

 

 

 ارزشيابي موضوع -1-1-2

لويت، قابليت بررسي آن به روش علمي، در دسترس بودن امكانات وبايد موضوع را از نظر اهميت و ا

مورد ، مورد لزوم ينجود، عملي بودن آن، فراهم بودن امكانات آزمايشگاهي، فراهم بودن متخصصمو

 .هيدبررسي قرار د

آيا تحقيـق   ،بر روي اين نكته تمركز كند كه در صورت به نتيجه رسيدن موضوعبايد محقق از ابتدا 

 ؟يا نهاست ارزش  داراي مورد نظر با صرف وقت و بودجه

مهـر  شهر شيراز از اول سال  5زير هاي  بررسي شب ادراري در بچه« :ا در نظر بگيريدمثلا موضوع زير ر

اين موضوع داراي ايراد است چون بررسي در مورد شب ادراري در كـل   .»88تا پايان بهمن ماه  88ماه 

هاي مختلـف بـه ايـن موضـوع نگـاه كنيـد        اگر از جنبه .يسترساند كه عملي ن كودكان يك شهر را مي

 
 دن يكي از مسيرهاي فوق آغاز نوشتن طرح تحقيقاتي با مشخص نمو

 نوشتن موضوع 

 ارزشيابي موضوع
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جامعه مورد نظر بايـد بـه صـورتي    . ل زيادي را مبني بر غير عملي بودن آن بدست آوريديانيد دلاتو مي

توان در كودكان مراجعه  همين بررسي را مي باشند كه قابليت دسترسي به آنان وجود داشته باشد مثلاً

رسـيدن  پس محدود كردن مساله كمك بزرگي به . كننده به يك بيمارستان تخصصي اطفال انجام داد

بهتر است كه محقق در آن واحد بر روي يك موضوع تمركـز كنـد تـا بـه      .كند به پايان كار مي پژوهش

كليفورد پيشنهاد داد كه پژوهش بايـد بـا توجـه بـه سـئوالي كـه        1997در سال . نتيجه مطلوب برسد

سئوال بـود كـه   كند و نوع مطالعه او انجام شود و هر گاه محقق به دنبال پاسخ به اين  محقق مطرح مي

 .تواند امر تحقيق را دنبال كند بهتر ميچگونه است؟  دط موجويدهد؟ و شرا مي يچه رو

مشـخص  آن را و زمـان و مكـان    عه، چگونگي مطالهعامعه مورد بررسي، متغيرهاي مورد مطالجبايد 

ك عامل ولي هر گاه به دنبال پاسخ براي سئوالي در مورد همبستگي بين متغيرها و يا نقش ي. كنيم

چون رابطه بين متغيرها ذكر زمان و مكان پژوهش ضرورتي ندارد هستيد مورد نظر در ايجاد پديده 

لاً كند  هاي مكاني مختلف تغييري نمي تحت تاثير زمان خاص نيست و در موقعيت گيـري   انـدازه  :مـث

 .ميزان روي سرم در بيماران مبتلا به سرطان مري و معده

در كارهاي توصيفي حتما مكان و زمـان را ذكـر    .كنيدمناسب استفاده  در نوشتن موضوع از كلمات

چند  هر(از به كار بردن كلمات اختصاري  بسازيد كه گويا باشد وبطور كلي عنوان را با كلماتي . كند

 .خودداري كنيد) در رشته شما شناخته شده باشند

 

 

 

 

 

 

 آغاز نوشتن طرح تحقيقاتي
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 بررسي متون علمي 2-2

 بـا دانـش روز   به كمـك اي باشد تا بتواند  ي كتابخانهنبال بررسخاب موضوع، محقق بايد بدپس از انت

ده سـال اخيـر    مربـوط بـه  تا آنجا كه ممكن است اين اطلاعات بايد  .شنا شودآموضوع مورد بررسي 

كند كه بتواند موضوع مورد نظر را از ديدگاه محققـين   اي به محقق كمك مي بررسي كتابخانه. باشد

بررسـي متـون بايـد بـر اسـاس      . عف آن را مورد ارزيابي قـرار دهـد  مختلف بررسي و نقاط قوت و ض

و بـا   هاي يك اندازه تهيه كنـد  بهتر است محقق مطالب مختلف را در سربرگ .لمي باشدع مطالعات

را در اتصـال مطالـب    ييكمك بالا متن را كدگذاري كند اين كار ،برگدادن موضوع بر بالاي هر سر

هـا   اين سربرگ .د يك متن نوشته شود و رفرانس آن مشخص گرددكند در هر سر برگ باي به ما مي

به محقق كمك مي كند كه بتواند در نهايت آنان را در كنار هم قرار داده و بيان مسئله خـود را بـه   

گيري ميزان روي سرم در بيمـاران   واهيم در مورد اندازهخ فرض كنيد ما مي مثلاً. ي بيان نمايد يزيبا

ود و خ ـايـن اسـت كـه اول تيتـر هـاي       دمحقق نيازمن ـ ،و معده تحقيق كنيم مبتلا به سرطان مري

سـرطان   –سـرطان مـري   –رويتواند به صورت  زيرمجموعه آنها را مشخص كند اين تيترها مي

تـوان بـا    مـي  رويكنـد مـثلا بـراي     باشد در مرحله دوم زيرمجموعه هر كدام را مشخص مـي  معده

 رويندمين فلز مهم بدن است آغاز نمود و سپس به نقـش  توضيح كمي در مورد اين فلز و اينكه چ

و عـوارض آن در بـدن تـا     روي ي ماننـد كمبـود  يهـا  در سلامت پوست بدن پرداخت و زير مجموعه

توضيح داد و بـا توجـه بـه بررسـي متـون بايـد در مـورد         را و نقش آن در پوست بدن رويكمبود 

توضيحات لازمه را  ،ران سرطاني انجام گرفته استمطالعاتي كه در مورد اين فلز و كمبود آن در بيما

ي ايـن مـاده معـدني در تكثيـر     يفراهم كنيم و در صورتي كه لازم است در مورد عملكرد بيوشـيميا 

. دهـيم  در مورد سرطان مري و سرطان معده انجـام مـي  را همين ترتيب  ،سلولي مطلب فراهم كنيم

كه خواننده به راحتي بتواند به اهميت موضـوع در  مطالب ما بايد به صورتي در كنار هم چيده شوند 
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بينـيم نويسـنده آنقـدر در مـورد مسـائل       هاي متون مـي  در بسياري از بررسي. طي مطالعه پي ببرد

 .ماند از ديد خواننده به دور مي مختلف توضيح داده است كه اصل موضوع كاملاً

م قـرار دهـيم كـه بتوانـد     ه ـسـر  حاصل را طوري پشت  هاي سربرگپس از اتمام بررسي متون بايد 

بايـد  . يميموارد اضافه را حـذف نمـا   ،منظور فوق را برساند و بايد با چند بار رو خواني منظم و دقيق

بـر ضـد نظريـه مـا      در بررسي متون بي طرف باشـيم و مـواردي را كـه كـاملاً     دقت كنيم كه كاملاً

مـا بـه خـوبي مـورد      »بحـث «قسـمت   توانند در ي خود مياين موارد به خود .بيان كنيم ،باشند مي

در حقيقت محقق با وارد نمودن نظريات مخالف و موافق در مورد موضوع مـورد  . استفاده قرار گيرند

باشـد و نشـان    سـاير محققـين نمـي    يوع هنوز مورد تائيد و اتفاق آراضدهد كه مو تحقيق نشان مي

ي اوقات محقق مجبـور اسـت كـه از    برخ. دهد كه نياز به بررسي مجدد در اين مسئله وجود دارد مي

مـورد عنايـت    هـاي قبـل   تحقيقات سال از كه يك سري استمنابع قديمي استفاده كند و علت اين 

محقـق بـا بـازنگري     شده،متوقف اين تحقيقات به صورت نيمه كاره قرار نگرفته است و  اساتيدساير 

در اين مـوارد محقـق علـت    . ايدنمي يگشاديدي را در علم بازجمسير  دتوان ميات در اين نوع تحقيق

 .كند ميذكر به اختصار در مطالعه يمي را داستفاده از منابع ق
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 هدف كلي -1-3-2

اگـر   باشد مـثلاً  ايد و قصد شما رسيدن به آن مي شما همان است كه در عنوان ذكر كردهدف كلي ه

اشد هدف اصلي شما ب» گيري ميزان روي سرم در بيماران با سرطان مري و معده ندازها«عنوان شما 

بررسي شيوع كم خوني «گيري ميزان روي سرم در اين دو نوع سرطان است و اگر عنوان شما  اندازه

باشد هدف شما تعيـين ميـزان    »هاي سالمندان شهرستان شيراز سال خانه 60اد بالايردر اف كشنده

 .هاي سالمندان شهرستان شيراز است سال مقيم در خانه 60شيوع كم خوني كشنده در افراد بالاي 

 اهداف جزئي -2-3-2

اهـداف  يند در حقيقت محقـق هـدف خـود را بـه     آ اين اهداف از خرد كردن هدف اصلي بدست مي

 :ي عبارتند ازيبراي موضوع فوق اهداف جز كند مثلاً كوچكتري تقسيم و بيان مي

تعيين ميزان كم خوني كشنده بـر اسـاس بسـامد     –تعيين ميزان كم خوني كشنده بر اساس جنس

 مواد غذائي 

گيـري بسـامد مـواد     ي دوم را دنبال كند لازم است كه انـدازه يدر صورتيكه محقق بخواهد هدف جز

ي را در طرح خود بگنجاند و براي رسيدن به اين منظور بايد از پرسشنامه بسـامد مـواد غـذائي    يغذا

ي را كه در نظر بگيريم بايد در خاتمه طرح يفراموش نكنيم كه هر هدف جز. استاندارد استفاده كند

گيري  دازهنظر ما نيست و يا در توان انمد يم از اين نظر نوشتن اهدافي كه اصلاًهدف پاسخ دهبه آن 

 .گردد طرح ما قرار ندارد يك اشتباه محسوب مي

 هدف كاربردي -3-3-2

فرض كنيم كه  باشد كه محقق در نهايت قصد دستيابي به آن را دارد مثلاً هدف كاربردي هدفي مي

برنـد بدينوسـيله    هاي سالمندان از كم خوني كشنده رنج مي محقق ثابت كند كه افراد مقيم در خانه

قرار دهد كه ايـن امـر را    به اين افراد) B12(دف كاربردي خود را مبني بر ويتامين ياري تواند ه مي
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يـن گونـه امـور يـا     اتواند به مديران اين مجموع ارائه داده و يا در قالب يك گزارش بـه متوليـان    مي

 .هاي مربوطه ارائه نمايد سازمان

س خودداري كنيد و اهداف خود را بـه  در نوشتن اهداف دقت كنيد كه از به كار بردن كلمات نامانو

گيري باشد و اهداف خـود را در راسـتاي مطالعـه     صورتي بنويسيد كه با ابزارهاي موجود قابل اندازه

يـك سـري   . خـودداري ورزيـد   رندقرار داده و از نوشتن اهدافي كه اصولا ارتباطي به كار تحقيق ندا

افعـالي   داشـته باشـيد  زمه را نوشتن آنها دقت لاروند كه بايد در  كلمات در نوشتن اهداف به كار مي

اهيتـا مـبهم   مو توصيف كردن مناسب هستند ولي افعالي كه گيري كردن  مانند تعيين كردن، اندازه

 .گردند نامناسب تلقي مي ،هستند مانند درك كردن و اعتقاد داشتن

وانيـد ابتـدا سـئوالات    ت پس از نوشتن اهداف بايد سئوالات پژوهش را بيان كنيد براي ايـن كـار مـي   

دهـد   ايت به كدام يك از آنها پاسخ ميهمختلفي را مطرح كنيد و سپس ببينيد كه تحقيق شما در ن

چند درصد از سالمندان مبتلا به كم خوني «توانيد اين سئوال را كه  براي موضوع فوق شما مي مثلاً

 .درا مطرح كني »كشنده هستند

 

 

 

 

 

 

 

 

 

 آغاز نوشتن طرح تحقيقاتي

 ارزشيابي موضوع ضوع نوشتن مو

 بررسي متون علمي 

 مشخص كردن اهداف اصلي ، فرعي و كاربردي 

 نوشتن فرضيه هاي پژوهش و سئوالات پژوهش 
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 اي پژوهشه فرضيه -4-2

گيري نداشته  جهت ،بايد محقق ،هاي خود را مطرح كنيد در اين راه پس از تعيين اهداف بايد فرضيه

بينـي   در حقيقت فرضيه يـك نـوع پـيش   . باشد و از پيش داوري و يك سو نگري بشدت پرهيز كند

. دهـد  خ مـي محقق به آنها پاس ـ ،هاي تحقيق گيري باشد كه در نهايت با آزمايشات و اندازه محقق مي

ح نمود و در راسـتاي  رهاي علمي را مط فرضيه بايد روشن باشد و در نوشتن آنها بايد تئوري و نظريه

 .گيري باشد بايد ساده بيان شود و با ابزارهاي موجود قابل اندازه ،مانند اهداف و تحقيق ما باشد

 مشخص كردن متغيرها -5-2

متغيرها را . متغيرهاي خود را كاملاً مشخص كنيم پيش از شروع به نوشتن روش و متد بررسي، بايد

 كنيم  بندي مي دسته مركب همراه كيفي ،كمي به

 

 

 

 

 

 

 

 

 

 

 

 

ارزشيابي  نوشتن موضوع 
 موضوع

 بررسي متون علمي 

 دي مشخص كردن اهداف اصلي ، فرعي و كاربر

 نوشتن فرضيه هاي پژوهش و سئوالات پژوهش 

متغير كمي 
.... 

 مشخص كردن متغيرها     

 متغير همراه بمتغير مرك متغير كيفي 
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 متغيرهاي كيفي -1-5-2

هاي خوني، دوست داشـتن و   گروهباشند، مانند  گيري مي متغيرهاي كيفي فاقد ابزار لازم براي اندازه

 .نداريم گيري آنها متنفر بودن كه معياري براي اندازه

 

 ي كميمتغيرهاانواع  -2-5-2

لاً . باشـند  گيري مي گيري و كيفي فاقد ابزار لازم براي اندازه متغيرهاي كمي قابل اندازه قـد يـك    مـث

متغيرهـاي كمـي را بـه     .باشـد  گيـري مـي   باشد كه بوسيله متر و اجزا آن قابل اندازه متغير كمي مي

 .كنند بندي مي متغيرهاي كمي پيوسته و گسسته دسته

 

 

 

 

 

 

 

 

 و كمي گسسته متغير كمي پيوسته -1-1-5-2

سـب  حتوانيم بر  گيرد مانند وزن كه مي متغيري است كه تمام اعداد را به همراه اعشار آنها در بر مي

گسسته فقط عدد صحيح است مانند تعداد فرزند  يكيلو و گرم در فرد مشخص كنيم ولي متغير كم

 .در بر گيردتواند كسري را  باشد و نمي مي 4يا  3يا  2كه 

 متغير مركب -2-1-5-2

 متغير هاي كمي 

 متغيرهاي خود را مشخص كنيد

 متغيرهاي مركب  متغيرهاي كيفي 

با متغيرهاي كوچكتر آن را 
 تعريف كنيد 

 كمي گسسته كمي پيوسته 

 وابسته مستقل وابسته مستقل
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ماننـد   باشد كه محقق مجبور است با استفاده از چندين متغير سـاده آن را نشـان دهـد    متغيري مي

اش، نوع واحد مسكوني كـه   ميزان درآمد فرد و افراد خانواده ،براي اين متغير مثلاً ،وضعيت اقتصادي

 كنند را تي تعداد فرزندان فرد كه در دانشگاه آزاد تحصيل ميباشد و ح شامل ملكي و استيجاري مي

 .در نظر گرفت بايد

شوند، متغيرهاي وابسته و متغيرهاي  اي كه با هم دارند به دو دسته تقسيم مي متغيرها از نظر رابطه

گيـري   يك دارو را بر ميزان كاهش قند خون انـدازه  تاثيرخواهيم  در يك بررسي ما مي مثلاً. مستقل

باشد در هر دو حالت دارو بـه عنـوان    كنيم و يا هدف ما مطالعه اثر يك دارو بر فشار خون بيمار مي

به عنوان متغيـر وابسـته تلقـي    ) در اينجا فشار خون يا قند خون(متغير مستقل و متغير روبروي آن 

قل و ات بايد طوري عمل كنيم كه متغيـر ديگـري بـر روي متغيـر مسـت     عدر اين نوع مطال. گردد مي

و هميشـه   پـذير اسـت   امكـان ط يوابسته ما تاثير نگذارد ولي ايـن امـر فقـط در يـك سـري از شـرا      

توانند به نوعي بر متغيرهاي مـا تـاثير بگذارنـد، بـه ايـن متغيرهـا        متغيرهاي ديگري هستند كه مي

 .شود فته ميمتغيرهاي همراه گ

 

  متغيرهاي همراه -3-1-5-2

متغير وابسته رابطـه   باغير مستقل و هم با متغير وابسته و يا فقط اين متغيرها ممكن است هم با مت

بين متغيرهاي مطالعه تواند رابطه  كنيد چون مييي هميشه شناسا ،متغيرهاي همراه را. داشته باشد

كنـيم عوامـل بسـياري     در زماني كه بـر روي بيمـاران ديابتيـك تحقيـق مـي      مثلاً. درا مخدوش كن

توانـد معيـار    الـت نمـي  حن اين بيماران تاثير بگذارند و قند ناشتا در ايـن  توانند بر روي قند خو مي

در ايـن مـورد    HbA1cخوبي براي سنجش كنترل قند بيمار باشد براي همـين امـروزه از متغيـر    

در بررسـي يـك متغيـر    . دهـد  كنند كه ميانگين قند سه ماهه گذشته بيمار را نشان مي استفاده مي

. ذارندگيري ما تاثيري نگ ي كنيم تا در نتيجهيشناسا يرهاي همراه را كاملاًوابسته و مستقل بايد متغ
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يـك  . يمي، متغيري را كه تحت تاثير متغيرهاي همراه نيست انتخاب نماو از ميان متغيرهاي مختلف

در زنان دانسـت محقـق بيمـاران را مـورد      B6توان بررسي كمبود ويتامين  مثال در اين مورد را مي

كند كه زنان در سنين باروري مبتلا به كمبـود ايـن ويتـامين     اده و در نهايت اعلام ميبررسي قرار د

كردند و مقايسه آنها  هاي ضدبارداري مصرف مي بعد از بررسي و جدا كردن زناني كه قرص. باشند مي

باشـد و   هاي ضدبارداري مي شويم كه علت كمبود اين ويتامين مصرف قرص ه ديگر متوجه ميوبا گر

شود و همراه كردن كليه زنان بدون در نظر گـرفتن   كمبود در ساير زنان مورد مطالعه ديده نمياين 

در اينجـا  . گيـري گشـته اسـت    ها باعث اشتباه در نتيجه مصرف قرص بارداري در يك سري از نمونه

 .گردد نقش مطالعه دقيق در ابتداي بررسي مشخص مي

. باشـد  ودن دقيق متغيرهـاي مـورد بررسـي مـي    اتي مشخص نبقهاي تحقي يكي از مشكلات در طرح

توانـد   ي مانند ناراحتي معده مييمتغيرها. ، غير قابل تفسير و قابل سنجش باشندبايد واضح متغيرها

در بر بگيرد و محقق بايد يك تعريف كاربردي از آن بيان كنـد تـا   را طيف وسيعي از مشكلات معده 

يـك   ،متغيري مانند خونريزي از زخـم  مثلاً. نمايد يآوري م ها را چگونه جمع مشخص گردد كه داده

تواند با اسـتفاده از   گيري آن مشخص نيست ولي محقق مي اندازه روش باشد كه متغير نامشخص مي

 .گيري آن به صورت اسـتاندارد بيـان كنـد    ساير مطالعات يا منابع علمي موجود روشي را براي اندازه

قابـل   هـاي را تبـديل بـه متغير   آنهـا يرهـاي مـورد بررسـي    محقق با تعريف واضح و كاربردي از متغ

تواند با توجه به منابع موجود يك چك ليست را براي اين نـوع متغيرهـا    محقق مي. كند سنجش مي

ايـن چـك ليسـت     طبق اين ليست در طرح وارد و يا از مطالعه خـارج نمايـد   را درست كند و بيمار

هاي مختلفـي تقسـيم كنـد     اساس شواهد موجود به دستهبيماران را بر  ،تواند در حالت پيشرفته مي

 .مانند بيمار با خونريزي كم، متوسط و زياد
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 ها انواع مقياس -6-2

باشـند بـه چهـار گـروه      ها بر مبناي اينكه متغير ما كمي، كيفي، پيوسته و يـا ناپيوسـته مـي    مقياس

 :شوند كه عبارتند از تقسيم مي

 ميمقياس سنجش اس -1-6-2

تـرين   هاي مختلفي را بر اساس متغيرهاي خود انجام دهيم سـاده  بندي توان دسته در يك مطالعه مي

و  كننـد  مـي  بنـدي  و گروه زن و مرد دسـته دباشد كه افراد را به  بندي بر اساس جنس مي آنها دسته

و نـوع   لتوانـد شـامل وضـعيت تاه ـ    هاي ديگر مـي  بندي دسته. دهند ها را مورد بررسي قرار مي داده

توان بـه   مي را و همسر مرده است و متغير مذهب گرفته ، مجرد، طلاقمذهب باشد كه شامل متاهل

هـاي فـوق    بنـدي  بينيم كـه هـر كـدام از دسـته     مي. بندي نمود دسته... مسلمان، مسيحي، يهودي و

بـل شـمارش   هـاي قا  تـوان داده  هاي مربوط به آنان را مـي  باشد و داده نمايانگر يك گروه از افراد مي

 .نمودمحسوب 

 وابسته مستقل وابسته مستقل

 متغير هاي كمي 

 كمي گسسته كمي پيوسته

 مشخص كردن متغيرها

 مشخص كردن مقياس هر متغير

  نسبتي اي  فاصله اسمي   اي رتبه
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 اي مقياس سنجش رتبه -2-6-2

شـود   ها از اين نـوع مقيـاس اسـتفاده مـي     باشد در بيشتر پرسشنامه بندي مدنظر مي در اين جا رتبه

 5تواند شامل پاسخ به يك سئوال باشد كه  مي هاترين آن ساده. تائي ليكرت 5تائي يا  4مانند مقياس 

اين مقياس در زماني بـه  . گيرد يف و خيلي ضعيف را در بر مي، ضع، خوب، متوسطمورد بسيار خوب

 .بندي مدنظر باشد رود كه رتبه كار مي

 

 اي مقياس سنجش فاصله -3-6-2

بندي شده است در  باشد كه با مقادير مساوي درجه اي مي اين مقياس در حقيقت همان مقياس رتبه

قيقـت مـرزي در   حخوب قرار دهيد، در توانيد يك خط بين بسيار خوب و  اي شما نمي مقياس رتبه

اي شما فاصله را معـادل مقـادير مسـاوي در نظـر      اي وجود ندارد ولي در مقياس فاصله مقياس رتبه

ر واقعـي در ايـن   فسنجند بايد توجه نمـود كـه ص ـ   ين مقياس ميادرجه حرارت را با  گيريد مثلاً مي

 .نيست كه درجه حرارت نداريم هوا صفر درجه است به اين مفهوم مثلاً. مقياس هم نداريم

 

 مقياس سنجش نسبتي -4-6-2

تـوانيم   هاي مقياس قبلي را دارد و صفر واقعي هم دارد با اين مقياس ما مي يگاين مقياس تمام ويژ

باشـد و يـا    درآمد افراد گروه الف دو برابر افراد گروه ب مـي  نسبت را بين دو عامل نشان دهيم مثلاً

 .برابر استاندارد جهاني است 5اي زير يك ماه در افغانستان ه ميزان مرگ و مير بچه

لاً . در يك طرح تحقيقاتي لازم است كه شما نوع متغير و مقياس سنجش آن را مشـخص كنيـد    مـث

كنيـد و يـا جـنس يـك متغيـر       سن را يك متغير كمي پيوسته و نوع مقياس آن را نسبتي بيان مي

 .باشد كيفي و مقياس سنجش آن اسمي مي
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 روش و متد تحقيق -7-2

جمعيت مورد بررسي و مكان مورد . وددر اين قسمت بايد به دقت مراحل انجام تحقيق را مشخص نم

كنـيم بايـد منبـع آن را ذكـر      اگر از پرسشنامه خاصي استفاده مي. دهيم در چند خط توضيح مي نظر را

نموده و در صورتي كه روش خاصـي   شخصبايد به دقت مراحل را م مراحل آزمايشگاهيكنيم و براي 

خواهيم فلز روي را در بيماران سرطاني انـدازه   مي  مثلاً. آن را مشخص كنيم ،نظر است با ذكر رفرانسمد

گيـري را بوسـيله    ايـن انـدازه   را مشخص كنيم مثلاً نري آيگ اندازه روش گيري كنيم بايد در اين مرحله

باشد چون محقق  دهيم ولي نوشتن همين اندازه كافي نمي جام ميان  xدستگاه اسپكتوفتومتر اتمي از نوع

گيري بايـد يـك سـري     گيري تا زمان اندازه بيند كه از زمان خون با كمي جستجو در مقالات مختلف مي

ها از نوع بخصوصي لوله به نام نونك استفاده كند و آنها را با آب يك بار  براي لوله موارد را رعايت كند مثلاً

 روش آماري 
 

 مقياس هر متغير را مشخص كرديد حال زمان نوشتن روش و متد تحقيق است 

اي ه پرسشنامه
 مورد بررسي

جمعيت 
مورد 

 

 هاي آزمايشگاهي  روش
 

محل مورد 
  

نحوه روائي 
 و پايائي

ذكر هر روش با 
تعيين حجم  استفاده از منابع 

 

كدام روش آماري را استفاده 
 كنيم  مي

 گيري  روش نمونه
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هـا را بوسـيله كاغـذ پـارافين      يك مرتبه شستشو دهد و سپس لوله قطيرب دو بار تآو با  مرتبهدو تقطير 

توانند در نتيجه ما تاثير بگـذارد و   باشند و مي مسدود كند چون گرد و غبار موجود در هوا داراي روي مي

ها مورد  وژ شوند و دهدقيقه سانتريوف 10دور در دقيقه به مدت  3000ها در  بايد خون گيري در زمان خون

گيري دقيق از اين فلز را به محقق بدهد تمام اين موارد  رعايت شود تا بتواند يك اندازه ديگر كه بايد كاملاً

 .گيري بايد بر اساس منابع موجود نوشته شود در روش اندازه

كنـد و  بينيم كه محقق قصد دارد يك يا چند پرسشنامه را در طرح خـود اسـتفاده    برخي اوقات مي

كـه بـه نظـر خـود و همكـارانش مناسـب        د،كن بدين منظور اقدام به نوشتن يك سري سئوالات مي

دهد و آناليز خـود را بـر اسـاس ايـن      باشد و سپس پرسشنامه را تكثير و در اختيار افراد قرار مي مي

 صـورتي  باشد محقق در نمايد اين يك روش اشتباه مي گيري مي و نتيجه دهد مي ها انجام پرسشنامه

هـاي اسـتاندارد كـه طـي      صصي در امر تحقيق خود دارد بايد از پرسشـنامه خكه نياز به پرسشنامه ت

 .استفاده كند ،ي آنان مشخص شده استيي و پايايتحقيقات قبلي روا

 

 روش آماري -1-7-2

در روش آماري سه قسمت نمونه برداري، تعيين حجم نمونه و اينكه از كدام روش آماري در تحقيق 

 .شود خود استفاده كنيم توضيح داده مي

 

 

 

 

 

 

 تعيين حجم نمونه 

 روش آماري

كدام روش آماري را استفاده 
 كنيم  مي

 

 گيري  روش نمونه
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 گيري نمونهروش  -1-1-7-2

باشد كه اگر به نحو صحيح انجام نشـود   هاي طرح تحقيقاتي مي يكي از مهمترين قسمت گيري نمونه

بـه   گيـري  نمونـه . آيـد  مـي بدسـت   تحقيقكه در طي  شودي يها باعث از بين رفتن واقعيتتواند  مي

 :شود كه عبارتند از ام ميهاي مختلفي انج صورت

 

 

 

 

 

 

 تصادفي ساده گيري نمونه -1-1-1-7-2

توانيم بـه يـك    استفاده از يك ماشين حساب مهندسي مي با با استفاده از جدول اعداد تصادفي و يا

گذاري كنيم و سپس با توجـه بـه    براي اين كار بايد افراد را شماره. سري اعداد تصادفي دست يابيم

خـواهيم از   در زماني كه مـا مـي  . راد مورد نظر را به روش تصادفي ساده بدست آوريمحجم نمونه، اف

فـرض كنـيم    باشـد مـثلاً   مـي  مناسـب روش ايـن   ،تعدادي نمونه انتخـاب كنـيم   ،بين يك جمعيت

نفره را انتخاب كنيم و ميزان فقـر   400ك نمونه يخواهيم از بين دانش آموزان دختر دبيرستاني  مي

هـاي دخترانـه را در    مورد سنجش قرار دهيم، ابتدا كافي است كه تعـداد دبيرسـتان  آنان آهن را در 

نظر را ابتـدا بـه چهـار ناحيـه      بهتر است كه شهر مورد براي شروع كار. شهر مورد نظر انتخاب كنيم

ي تقسيم كنيم و اين نواحي به صورتي باشد كه مشخص كننده تفكيـك از نظـر اقتصـادي    يجغرافيا

هاي هر ناحيه رامشخص كنيم و از روي جدول اعـداد تصـادفي از هـر ناحيـه      تانباشد سپس دبيرس

 ريروش آما

 گيري روش نمونه

 غيرتصادفي  شماري سر اي خوشه اي طبقه منظم  تصادفي 

 نسبتي تعمدي
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آمـوزان بـه روش    يم و در هـر دبيرسـتان بـا دادن شـماره بـه دانـش      ييك دبيرستان را انتخـاب نمـا  

 .كنيمآموز را انتخاب  دانش 100برداري تصادفي  نمونه

 

 گيري سيستماتيك يا منظم نمونه -2-1-1-7-2

بطـور  . درگي يت با حجم زياد انجام ميعي زماني است كه مطالعه بر روي يك جميك روش ساده برا

انجام اين كار ابتـدا   يبرا يمكن پرونده را انتخاب 100پرونده تعداد  15000از بين  يممثال قصد دار

بـراي مثـال فـوق     .سـيم بر ثابت به يك عدديم ينما تعداد كل را به تعداد نمونه مورد نظر تقسيم مي

باشد با پيدا نمودن اين عدد بايد به جدول اعداد تصادفي و يا ماشين حسـاب   مي 150ما  بتثا عدد

اين عدد را بـه   گردد مي 40آوريم مثلاً عدد ما  را بدست تصادفيمهندسي مراجعه كنيم و يك عدد 

مودن باشد سپس با اضافه ن مي 40گيريم و اولين پرونده ما پرونده شماره  عنوان پايه كار در نظر مي

دهيم تا به صدمين عدد برسيم  آوريم و به همين ترتيب ادامه مي عدد بعدي را بدست مي ،عدد ثابت

 .گردد مي...  و 340، 190ما شامل  بعدي به اين ترتيب اعداد

 

 اي طبقه گيري نمونه -3-1-1-7-2

در يـك  كنـيم مـثلا    به طبقات مختلـف تقسـيم مـي   افراد را برحسب يك متغير  گيري در اين نمونه

سـپس از داخـل هـر     دهـيم  كارخانه افراد را در طبقات كارگر، كارمند، تكنسين و مهندس قرار مـي 

ست كـه واريـانس درون   ا در اينگيري  حسن اين نمونه. كنيم طبقه افرادي را به تصادف انتخاب مي

د را در بطور مثال درآم. باشد ست كه واريانس بين طبقات زياد ميا طبقات كم ولي عيب آن در اين

 .مي باشد زيادنظر بگيريد كه واريانس آن در هر طبقه كم ولي از يك طبقه به طبقه ديگر 
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 اي خوشه گيري نمونه -4-1-1-7-2

طوري انتخاب كنيم كـه از هـر    وشه راخست كه هر ا اي اين خوشهگيري  رين روش در نمونهتساده 

است در هر خوشه  اي عمل كنيم كافي هاگر بخواهيم خوش يدر مثال قبل ،باشد موجود در آن ،گروه

ها را به عنـوان نمونـه انتخـاب     سپس تعدادي از اين خوشه نسين، كارمند و كارگر باشدك، تمهندس

 حسن اين نوع نمونه بـرداري در ايـن  . دهيم كنيم و كليه افراد آن خوشه را مورد بررسي قرار مي مي

. باشد ها زياد مي ست كه واريانس درون خوشها ها كم و عيب آن در اين ست كه واريانس بين خوشها

و يـا  قرار دادن چند روسـتا   شود مثلاً ات استفاده ميعاي در بيشتر مطال خوشه گيري امروزه از نمونه

ها را بيشتر در نظر بگيـريم   اي تعداد نمونه خوشهگيري  بهتر است در نمونهدر هر خوشه چند خانوار 

براي رسـيدن بـه   . به روش تصادفي ساده استگيري  از نمونهل واحدهاي مطالعه كمتر چون استقلا

، تعـداد  كه پـس از تعيـين تعـداد نمونـه لازم    اي لازم است  خوشه گيري حجم نمونه واقعي در نمونه

براي . يميگيري بنما بدست آمده را سه برابر كنيم تا جبران خطاي سيستماتيك را در اين نوع نمونه

در نظر نفر  21در هر خوشه را كمتر از  افرادهاي موجود تعداد  قعيتزمون به واآتعميم دادن نتيجه 

 .گيريم مي

 

 به روش سرشماريگيري  نمونه -5-1-1-7-2

كننـد در   كليه بيماراني را كه به يك مركز در طول مدت معين مراجعـه مـي   گيري در اين نوع نمونه

اند ولي اگر  مركز را انتخاب كرده كساني هستند كه اين كليه هاي ما گيريم در حقيقت نمونه نظر مي

مراجعـه   هفتـه  هـاي زوج روزخود را بر اين اساس قرار دهد كـه افـرادي كـه در     گيري محقق نمونه

كنند در گـروه   به همان مركز مراجعه مي هفته هاي فردروزكنند در يك گروه و افرادي را كه در  مي

 .شود بلكه تصادفي ساده است ديگر سرشماري محسوب نمي گيري ديگر قرار دهد اين نمونه
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 تصادفيغير گيري نمونه -6-1-1-7-2

 .نـدارد  دهيچ قاعده خاصي كه بتواند شانس افراد را به هم نزديك كند وجـو  گيري در اين نوع نمونه

كاركنان يك اداره و يا انتخاب از بين همراهان بيمـار و يـا كسـاني كـه در     انتخاب افراد از بين  مثلاً

1Fاريبـي گيري همانطور كه مشخص اسـت   در اين نوع نمونه. دارنددرمانگاه حضور 

اگـر  . وجـود دارد  2

گيـري غيـر تصـادفي تعمـدي      باشد كه به آن نمونه انتخاب افراد خاص براي مطالعه از روي عمد مي

كارگر، كارمند، تكنسين و مهندس يك نسبت را  برخي اوقات محقق از هر طبقه مثلاً. شود گفته مي

 روش،ايـن  بـه   .باشـد  نسبت افراد هر طبقه به كل جمعيت مـي  كه اين نسبت دقيقاً كند انتخاب مي

را جمعيـت فـوق   نفر از  1000فرض كنيد ما  شود مثلاً اي گفته مي غير تصادفي سهميهگيري  نمونه

هدف . باشد مينفر  100و مهندس  300، تكنسين 100، كارمند 500داريم و تعداد كارگران برابر با 

، نفـر  50 گرانكـار  دادع ـهـاي فـوق ت   نفر از بين افراد فوق است با توجه بـه نسـبت   100ما انتخاب 

 .نفر مي باشد 30 تكنسينو  نفر 10 كارمند نفر، 10 مهندس

 

 

 

 

 

 

 

 

                                               
Bias2  

 روش آماري

 تعيين حجم نمونه

 دار بودن و توان آزمون را بشناسيم ابتدا چهار عامل واريانس، خطاي برآورد، سطح معني
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 هر چه واريانس متغير مورد بررسي كمتر باشد نشان دهنده همگن بودن بيشتر جامعه است

 تعيين حجم نمونه -2-7-2

محقق پس از مشـخص نمـودن نـوع    . براي هر تحقيق مشخص نمودن حجم نمونه بسيار مهم است

توصـيفي باشـد تعـداد نمونـه      ،اگر مطالعـات محقـق  . را مشخص كنداد نمونه بايد تعد ،مطالعه خود

قق در مطالعات توصـيفي  حبهتر است م. استبيشتري نسبت به مطالعات تجربي و نيمه تجربي لازم 

مـورد نيـاز بدسـت     نمونه به مطالعات مشابه در ساير نقاط دقت كند تا بتواند يك برآوردي از تعداد

هرچه تعـداد متغيرهـاي مـورد بررسـي      .متغيرها بسيار مهم است دتعدامونه، در تعيين حجم ن.آورد

اي محقق بايـد بـه ميـزان     هاي مقايسه بيشتر باشد بايد نمونه بزرگتري را انتخاب كنيم و در بررسي

يك رابطه  هاي مورد مقايسه نگاه كند در اين حالت بين حجم نمونه و ميزان تفاوت تفاوت بين گروه

ارد به اين معني كه هر چه تفاوت بيشتر باشد تعداد نمونه كمتري مورد نياز است و وجود د معكوس

 .برعكس

درصـد   15تـا   10بين  بايد محقق .باشد يك ضرورت در تحقيق مي ،انتخاب حداقل نمونه مورد نياز

در نظـر بگيـرد تـا ريـزش      ،تعداد نمونه را بيشتر از ميزان برآورد شده توسـط فرمـول حجـم نمونـه    

 .اران در طول بررسي را پوشش بدهدالي بيماحتم

هـا در نظـر    تفاوت واقعي مـابين گـروه  در تعيين حجم نمونه بايد قدرت روش آماري را در تشخيص 

 .باشد به تعداد نمونه كمتري نياز داريم بيشترگرفت هر چه اين قدرت در يك آزمون آماري 

م حج ـ. ه اطلاعاتي را در دسـترس دارد براي تعيين ميزان حجم نمونه بايد محقق بررسي كند كه چ

بزرگـي و مقـدار    -واريانس صفت مـورد مطالعـه  : نمونه به چهار عامل بستگي دارد كه شـامل 

اگـر  بايـد دقـت كنـيم كـه      .باشـد  مـي  تـوان آزمـون  و  سطح معني دار بودن -خطاي برآورد

 .انجام گيرد نياز به حجم نمونه كمتري داريمجامعه همگن گيري ما در يك  نمونه
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شود و با بالا بردن سطح  بگيريم حجم نمونه ما بيشتر مي رهر اندازه خطاي برآورد را كوچكتر در نظ

 .يابد اطمينان نيز حجم نمونه ما افزايش مي

 .در اين نوع مطالعات ما نياز به برآورد نسـبي جمعيـت داريـم    -حجم نمونه در مطالعات توصيفي

را قـرار دهـيم و ميـزان     96/1ه جاي سـطح اطمينـان عـدد    ست كه در فرمول با ترين راه اين ساده

اگر ما نسـبتي را از جامعـه   . بگيريم ردر نظ 01/0تا  05/0بين را  )يا خطاي قابل قبول(برآورد خطا 

فـرض   .در نظر بگيريم 5/0را  آن را در فرمول قرار دهيم در غير اينصورت نسبت ،مورد نظر داشتيم

ايـم تعـداد    در نظـر گرفتـه   05/0عي نداريم و ميزان برآورد خطـا را  كنيد كه ما اطلاعي از نسبت واق

 :نمونه ما برابر با

384
)05.0(

)5.5(.)96.1(
2

2

=
××

=n   

لاً  دهـيم،  براي زماني كه ما نسبتي را داريم آن را در فرمول قرار مي نسـبت حـاملگي    اي مطالعـه  مـث

مطالعه جديد براي بدست  بدست آورده است حال در 03/0با برابر  را در كشور آمريكاخارج رحمي 

را در نظر بگيـريم اگـر بخـواهيم بـا      03/0و  97/0بروز حاملگي خارج رحمي بايد دو نسبت وردن آ

ا ر 96/1عدد اطمينان درصد برآوردي از تعداد نمونه داشته باشيم به جاي سطح  95سطح اطمينان 

خواهيم انجام دهيم  رد كه ميكاري دا دقتبسته به  خطا گيري در مورد برآورد دهيم تصميم قرار مي

يـا   0,01باشد و محقق هر چه اعداد را كوچكتر در نظر بگيرد ماننـد   مي 05/0كه حداقل آن برابر با 

 .شود حجم نمونه او بيشتر مي... و  001/0
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باشد بايد حجم نمونه را به سه برابر افزايش دهيد تا خطاي  اي مي گيري شما خوشه اگر نمونه

 سيستماتيك را جبران كنيد

 

111790
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××

=n 

باشد كه تعداد نمونه را زياد يـاكم مشـخص    مي خطا برآوردم كه اين بيني با توجه به موارد فوق مي

 .كند مي

تواند  مي خطا برآوردبا استفاده از انحراف معيار و محقق  ،باشد در زماني كه مطالعات ما توصيفي مي

توان از مطالعات مشابه بدست آورد و در مواقعي كه  را ميانحراف معيار . حجم نمونه را مشخص كند

بـه طـور    .يميف معيار جامعه موجود باشد بايد در فرمول تعيين حجم نمونه از آن استفاده نمـا انحرا

انحراف معيار قند خون در جنـوب ايـران   خواهد بر روي قند خون مطالعه كند اگر  مثال محققي مي

نمونه درصد تعداد  95تمال حو ا 0,05 يخطا با برآورد ،باشد 625و واريانس آن برابر با  25برابر با 

 .نفر مي باشد 960400برابر با 
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فـرض كنيـد    برخي اوقات ما نياز به توان آزمون داريم تا بتوانيم حجم نمونه را مشخص كنيم مـثلاً 

غل دامـداري اشـتغال دارنـد و    باشد كه بـه ش ـ  ياني مييسرطان پوست در كشاورزان بيشتر از روستا

خواهيم با  حال مي. باشد درصد مي 6درصد و در دامداران برابر با  8نسبت اين سرطان در كشاورزان 

 .درصد حجم نمونه را مشخص كنيم 0,05درصد و در سطح معني داري  90استفاده از توان آزمون 
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 1,28ان توان آزمون نيز برابـر بـا   گردد و ميز مي 1,96درصد برابر با  0,05ميزان سطح معني داري 

 .دگرد مي

ايـن  . شـود  درصـد مـي   7كه برابر با  )ρ( كنيم ابتدا نسبت مشترك را در بين دو گروه محاسبه مي

شود بـا اسـتفاده از    يدرصد م 93و  7گيريم كه برابر با  در نظر مي )ρ−1(و ) ρ(نسبت را براي 

7                                                    .فرمول زير حجم نمونه را محاسبه كنيد
2

68
=

+ 

2
21

2
1

2
1

)(

)]1([)(2

ρρ

ρρβα

−

−×+
=

−
−

zz
n 

342
)6.8(.

)]93.7[.)28.196.1(2
2

2

=
−

××+
=n 

 گروهيك ي اين تعداد نمونه برانفر مي شود  342با توجه به اين فرمول حجم نمونه ما برابر با 

 .نمونه نيازمنديم 684پس اگر بررسي ما بر روي دو گروه باشد ما به . باشد مي

برابـر يـا    3تـا   ،نسبت شاهد به بيمارط معمول يدر شرا ،باشد اگر مطالعه به صورت مورد و شاهد 

 ،اگـر ايـن نسـبت   . اسـت  گيرند كه اين مسئله براي بالاتر بردن دقت در مطالعـات  بيشتر در نظر مي

شود و براي محاسبه حجم نمونـه   گفته مي (r)را بدست آوريم كه به آن  آن يشتر از يك گردد بايدب

 كنيم از فرمول زير استفاده مي
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 از اين فرمول استفاده كنيم  دبراي محاسبه نسبت مشترك نيز باي

1
)( 21

+
+×

=
r

ppr
ρ 



 بهداشت علوم پزشکی و راهنمای گام به گام در تحقيقات  

 

 

44 

 :باشد كه عبارتند از گري هم ميهاي دي براي تعيين حجم نمونه فرمول

در اينجا بايد واريانس و خطـاي معيـار يـك مطالعـه      :و برآورد يك نسبتبرآورد يك ميانگين 

و بتوانيم به اين مطالعه به عنوان مشابه با مطالعه ما باشد لعه بايد ااين مط. رفرانس را در نظر گرفت

2 كنـيم  استفاده مي حجم نمونهآورد فرمول براي براين از . استناد كنيممعتبر يك مطالعه 

2

e
sn = 

توانيد با تقسيم انحراف معيار مطالعه مورد نظـر بـر جـذر تعـداد نمونـه آن       را مي) e(خطاي معيار 

                                                                              بدست آوريد
n

SDSEe == 

هنگامي كه در مثال قبلي با يك مطالعه مواجه  :تعداد حجم نمونه لازم براي برآورد يك نسبت

2فرمول  اين ها را ارائه نموده است از هستيم كه نسبت

)1(
e

PPn −
 .كنيم استفاده مي =

عيار در دو محل براي يك با داشتن انحراف م :اختلاف بين دو ميانگين و اختلاف بين دو نسبت

 .توان تعداد حجم نمونه را بدست آورد متغير و همراه نمودن ميزان خطاي معيار مي

2

2
2

2
1

es
ssn +

= 

اي خود به دو بررسي در دو شهرستان مشابه برخورد كرده است كه در  محققي در مطالعات كتابخانه

و در دومـي ميـانگين وزن   گـرم   500عيـار را  و انحـراف م گـرم   3000اولي ميانگين وزن نوزادان را 

اند محقق با استفاده از مطالعـات ديگـر    ذكر كردهگرم  400و انحراف معيار را گرم  2800نوزادان را 

خواهد با استفاده از اين اطلاعـات حجـم    بدست آورده است و مي 20خطاي معيار استاندارد را برابر 

نجا محقق قصـد اسـتفاده از ميـانگين وزن نـوزادان در دو     در اي. نمونه مورد نظر خود را بدست آورد

 . خواهد از انحراف معيار بدست آمده در اين مطالعات استفاده كند شهرستان فوق را ندارد و تنها مي
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 ساير فرمولهاي رايج در تعيين حجم نمونه 

هـاي جـور شـده     مون فـرض ميـانگين زوج  آزباشد كه اطلاعات مربوط به  براي زماني مي زير فرمول

 .باشد مي

Hypothesis testing for paird sample means  

 

 

 

سـتقل قـرار دارد بـا اسـتفاده از     منسـبت  باشد كه فرضيه ما بر اساس دو  براي زماني مي زير فرمول

 .ييمنما اقدام به تعيين حجم نمونه مي ميانگين و واريانس در مطالعات ديگر

Hypothesis testing for 2 independent proportions 
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. يمينمـا  گيري حجم نمونـه مـي   مطالعات ديگر و داشتن ميزان نسبت در آن مطالعات اقدام به اندازه
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 .نظر داريمباشد كه ضريب همبستگي در يك مطالعه را مد براي زماني مي زير فرمول
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باشد كه فرضيه ما بر اساس مقايسه ميانگين در دو گروه مستقل  اين فرمول براي زماني مي

 .يميمان م نمونه ميج، با استفاده از ميانگين و واريانس در مطالعات ديگر اقدام به تعيين حباشد مي

Hypothesis testing for means of 2 independent groups (t-test)  
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دهيم و با اسـتفاده   در اين فرمول ما واريانس بدست آمده در مطالعات ديگر را مورد استفاده قرار مي

باشد حجم نمونه را براي مقايسـه   0,05ن بايد كمتر از آكه ميزان  dورد خطا آفاصله برآورد يا براز 

 .توانيم مشخص كنيم دو ميانگين مي

Hypothesis testing for means of 2 independent groups (t-test) 
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يك گروه را داريد ميـزان حجـم نمونـه را بـر اسـاس ايـن فرمـول         براي اگر قصد مقايسه قبل و بعد

 .و واريانس را از مطالعات ديگر بدست آوريد dمشخص كنيد اطلاعات مربوط به 

 

 

 

Hypothesis testing for paired sample means  

 

باشـد از فرمـول زيـر     براي تعيين حجم نمونه در يك مطالعه كه هدف آن مقايسه بين دو شيوع مي

 .استفاده كنيد 

Comparing 2 prevalance 

 

 

 

 .كنيم ير براي اين كار استفاده ميباشد از فرمول ز Ratio Oddsاگر هدف مطالعه شما برآورد 

Estimation of an Odds - Ratio 

 

 

 
 

α = error type 1                                  e = relative width of conf. interval  

p1 = proportion exposed in cases       p2 = proportion exposed in controls 
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Estimation of a Relative Risk  
α = error type 1    e = relative width of confidence interval 

p1 = proportion exposed in cases     p2 = proportion exposed in controls 

RR = p1/p2 

در مطالعه باشد از فرمول زير براي تعيين حجم نمونه  Odds Ratioاگر هدف شما آزمايش 

 .استفاده كنيد

 

 

Testing Odds Ratio > 1 

p1 = prevalence of exposure in cases 

 p2 = prevalence of exposure in controls 

 بندي جدول گانت و بودجه

بندي خود را به صورت دقيق انجـام دهيـد در ايـن     جدول زماني طرح خود را تكميل كنيد و بودجه

آن را در اختيار يك  ،باشد بهتر است قبل از ارائه آن به واحد مربوطه يماده آممرحله پروپوزال شما 

شـما پـس از    حطـر . را برطرف نمايـد آن، اشكالات احتمالي  با مطالعهفرد محقق ديگر قرار دهيد تا 

 .گردد آماده اجرا مي ،در واحد مربوطه و رفع نقايص نمطرح شد

 شروع يك طرح تحقيقاتي

همانطور كه گفته شـد اگـر لازم   . يديي كه بايد انجام دهيد آماده نمايابتدا يك چك ليست از كارها

بايد موافقت اداره مربوطه را در همان ابتداي نوشتن  انجام گيرد،است كه طرح شما در محل خاصي 

 .با مشكل مواجه نشويد ،طرح كسب كنيد تا در شروع

همكـاران  كمـك  زمان دقيق شروع طرح را بـا   ،هاي مربوطه پس از نوشتن چك ليست و ارسال نامه

 هاي مربوطه را تكثير نمـوده و در صـورتي كـه قسـمتي از طـرح در يـك       پرسشنامه .مشخص كنيد
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و مرحله آزمايش را چند بار به صورت آزمايشي تكرار گيرد در آنجا حضور يافته  آزمايشگاه انجام مي

 .با مشكل مواجه نشويدكارتا در زمان انجام  كنيديد و اشكالات را برطرف ينما

تيم شما بايـد آن را انجـام    وباشد  مي طرح شما بر اساس مراحل مختلفحالت دوم زماني است كه 

حضـور پيـدا كـرده و قـد و وزن دانـش آمـوزان دختـر را         مدرسـه قرار است كه در يـك   لاًدهند مث

 ،بهتر است ابتدا بـه صـورت يـك نمـايش     ،بگيريدميلي ليتر خون  5و از هر كدام  كنيدگيري  اندازه

مراحل كار را با تيم مربوطه بازسازي كرده و مسئوليت هر فـرد را در موقـع كـار مشـخص كنيـد و      

 .ييدرا يادآوري نما موارد لازمه

فراموش نكنيد كه در نقاطي از ميهن عزيز ما كه گـويش خاصـي متـداول اسـت لازم اسـت كـه از       

 .افرادي براي مصاحبه و يا پذيرش بيماران استفاده كنيد كه به آن گويش تسلط كافي داشته باشند

را بـه   دگي بيمارانكيفيت زنخواهيم به درمانگاه ديابت مراجعه كنيم و ميـزان   فرض كنيم كه مي

تلف كه خپرسشنامه م 5 فرض مي كنيم ازرا بسنجيم براي اين كار  مراقبت از خودهمراه وضعيت 

كنـيم و قصـد داريـم كـه از     مي ي آنان در مطالعات قبلي مشخص شده است، استفاده يي و پايايروا

HbA1c2Fبيماران خونگيري كرده و ميزان 

ه صـورت زيـر   را بسنجيم در اين حالت چك ليست ما ب 3

 :است

 روع به كار در درمانگاه نگاري با معاونت درمان در مورد اعلام زمان ش نامه •

ر و ارتبـاط  به كا عروز قبل از شرو 3حداقل  ،مراجعه به درمانگاه مورد نظر با معرفي نامه •

 با مسئول درمانگاه

 گذاشتن يك جلسه با همكاران درمانگاه در مورد طرح •

 مك مسئول درمانگاه و افراد ذيربطم كار در درمانگاه به كمشخص نمودن مراحل انجا •

                                               
ميانگين قند سه ماهه گذشته بيماران كه توسط كيت در آزمايشگاه سنجيده مي شود و يك معيار دقيق براي 

  3ديابت است
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 هاي مورد نظر به اندازه كافي چاپ پرسشنامه •

 آماده نمودن حواله رايگان آزمايشات مربوطه جهت آزمايشگاه  •

 مراجعه به آزمايشگاه و ارائه يك نمونه از حواله مربوطه همراه با مهر و امضاي مشخص  •

مثلا بيماران مراجعه كننـده در هفتـه اول    -يگير نوع نمونه بندي بيماران بر اساس دسته •

گيرند اين  قرار مي گروه شاهدو بيماران مراجعه كننده در هفته دوم در  گروه مورددر 

 .انجام دهيد رامسئله زماني اهميت دارد كه شما قصد داريد يك مداخله آموزشي 

 و سـه سـو كـور اسـت دقيقـاً      بايد دقت كنيد كه نحوه كار شما اگر براساس دو سو كـور  •

 .ها را طوري تقسيم كنيد كه اين موارد رعايت گردد مسئوليت

دقت كنيد كه قبل از شروع كار تمام موارد مـورد نظـر   . توانيد موارد ديگري را به بالا اضافه كنيد يم

 .يدينما حذ پياده و با همكاران خود اين موارد را مرور و اصلاغرا به دقت برروي كا

ي كه در محيط پژوهش هستيد بايد دائما مراحل كار را مورد ارزيابي قرار دهيد و مواردي يهادر روز

 .يديرا كه لازم است اضافه و يا اصلاح نما

 ها آوري داده جمع

هـا را   افزار آماري وارد كنـيم تـا بتـوانيم آنـاليز داده     ها بايد آن را در يك نرم پس از جمع آوري داده

باشـند كـه محبـوبترين آنهـا در نـزد       مي... و  SPSS، Minitabمانند افزارها  انجام دهيم، اين نرم

ها بر اسـاس ايـن    داده شد كه در اين كتاب تجزيه و تحليلبا مي SPSSافزار  محققين كشورمان نرم

 .گردد افزار ارائه مي نرم
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 :SPSSها به محيط  ورود داده

تر  هاي بالاتر و يا پايين شما با داشتن نسخه. ستاستفاده شده ا SPSS 16در اين كتاب از نرم افزار 

 .باشيد افزار قادر به استفاده از اطلاعات اين كتاب نيز مي اين نرم

 :بينيد افزار آن را به شكل زير ميدر بدو ورود به اين نرم 

 
 

 .ببنديد تا صفحه اصلي نمايان شود اين پنجره را cancelبا زدن دكمه 
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كه در پايين و سمت چپ صفحه قرار دارد كليـك كنيـد تـا بـه ايـن       variable view روي دكمه

 .متغيرهاي خود را تعريف كنيد ووارد شويد قسمت 
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 :وارد كنيد اطلاعات را هاي زير قسمتدر 

Name –  كنيد، با وارد كردن نام متغير و رفتن به رديـف بعـدي   تايپدر اين قسمت نام متغير را، 

دقـت كنيـد كـه نـام متغيـر را      . دهـد  ش فرض را براي شما نمايش مـي برنامه يك سري تعاريف پي

   Age ם 1 كنيد مثلاً تايپتوانيد با فاصله  نمي

 
هاي ديگر را تعريف كنيم كافيست كه بر روي دكمه نوار ابـزار كنـار    اگر بخواهيم هر كدام از قسمت

 :مكني به صورت زير عمل مي Type يير دادنغبراي ت آن كليك كنيم مثلاً
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Type- در شـود كـه    شود با زدن دكمه كنار اين گزينه اين پنجره نمايان مـي  همانطور كه ديده مي

روز شـروع   ، بـراي ورود روز مـثلاً  Numericتوانيم داده خود را به صـورت عـددي    اين قسمت مي

داده بـه صـورت   و يـا انتخـاب    currency پول رايج، براي ورود داده بر حسب dateبستري شدن 

 .كنيم انتخاب مي stringاي  تهرش

 .كنيم ميزان اعشار را مشخص مي decimalsطول متغير و با تغيير  widthبا انتخاب 

توانيد يك برچسب براي متغير خود تعريف كنيـد، چـون ايـن نـرم افـزار داراي       شما مي Lableدر 

كند تـا بـه    كمك مي باشد، اين برچسب به شما محدوديت در تعداد كاراكتر مربوط به نام متغير مي

 .يديدلخواه نام موردنظر را براي آن تعريف نما

متغيـر  اگـر   بندي مختلفي را براي متغير انجام دهيد مـثلاً  توانيد دسته شما مي Valuesدر قسمت 

در نظر بگيريد و .... را براي كارمند و  2را براي خانه دار و  1توانيد عدد  شما مي ،باشد شما شغل مي

اين مسئله بـه  . را براي زن انتخاب كنيد 2دد عتوانيد عدد يك را براي مرد و  جنس مي يا در متغير

فراموش نكنيد كـه در  . آسانتر بتوانيد عمل كنيدزيه و تحليل اطلاعات جكند كه در ت شما كمك مي

 .توانيد فارسي وارد كنيد هاي اين نرم افزار شما نمي بيشتر نسخه

measure  كنيد  گيري را معلوم مي به نوع مقياس متغير يكي از سه اندازهدر اين قسمت شما بسته

و بـراي متغيرهـاي    Nominalيرهاي اسمي غبراي مت Scale) قابل شمارش(براي متغيرهاي كمي

 .كنيدرا انتخاب  Ordinalترتيبي 
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واقع در پايين و سمت چـپ   view data دكمهمتغيرها بر روي  نام و مشخصات پس از وارد كردن

 .نماييدوارد  در زير نام هر متغير هاي خود را و داده دكليك كني صفحه

 
 

لازم است كه متغير سن را بـر   بندي كنيد مثلاً هاي خود را دسته ممكن است كه شما بخواهيد داده

بـراي  . بنـدي كنيـد   دسـته ... سال و  30سال تا  20سال،  20سال تا  10سال،  10تا  1اساس سن 

 :ت منوهاي زير وارد شويدم اين كار به قسمانجا

Transform>Recode into Different Variables 
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 .گردد با وارد شدن به اين قسمت، پنجره زير ظاهر مي

 
از جعبـه   را cu انجام دهيم براي اين كار متغير cuبندي بر اساس  خواهيم يك دسته در اينجا ما مي

نـام   Nameو در قسمت  كنيدوسط وارد به جعبه آن را  سمت چپ انتخاب كرده با كليك روي 

. كليـك كنيـد   Changeدكمـه   رويو  كنيـد و بر چسـب آن را مشـخص    بدهيدجديدي را به آن 

 .شويدبه پنجره بعدي وارد  Old and New Valuesسپس با كليك برروي 
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 9,99تـا   0و وارد كردن ميـزان مربوطـه كـه در اينجـا بـين       Rangeسپس با فعال كردن قسمت 

شود كه با كليك بـر روي   فعال مي Addبه آن در پنجره روبرو دكمه  Valueشد و دادن يك با مي

به همين ترتيب هر دسته را وارد كليك كنيد و  Continueروي  گيرد آن اولين دسته ما شكل مي

توانيم مقادير خـود را   با نگاهي ساده به كمترين ميزان و بيشترين ميزان و فعال كردن آنها مي كنيد

 .ر اساس كمتر از يك ميزان و بيشتر از يك ميزان تعريف كنيمب

 :زير مراجعه كنيد منوهايود دارد به بندي نيز وج راه ديگري براي تعريف دسته

Transform > Visual Binning... 

 
 .شود با ورود به اين قسمت پنجره زير نمايان مي
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 :مي شويدوارد  زيربه پنجره  Continue ، با زدن دكمهكنيدمتغير خود را به جعبه روبرو وارد 

 
 Cutpoints Make دكمـه  شـود، بـر روي   مختصات آن در پنجره ظاهر مي ،با كليك بر نام متغير

 .كليك كنيد تا به پنجره بعدي برويد
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و سپس زدن  مورد نظر و طول هر دسته هاي دستهدسته و تعداد  عدددر اينجا با وارد نمودن اولين 

 .گيرد بندي ما انجام مي دسته، Applyدكمه 

 
 .شود مي تثبيتبندي ما  دسته Okبا زدن 

ممكن است كه محقق در نظر داشته باشـد   -تعريف يك فرمول محاسباتي در محيط نرم افزار

گيـري   سـه نـوع كـدورت آب را انـدازه    يك فرمول را تعريف كند فرض كنيد كه در يك بررسـي مـا   

بـه مـا    Total kodoratمجموع آنها را در قالب يك متغير بـه نـام   خواهيم نرم افزار  ايم و مي كرده

 Transform>Compute Variable                       :از منوهاي زير استفاده كنيد .ارائه دهد
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 :شود پنجره زير نمايان مي منوهابا كليك بر روي اين 

 
 

 Targetدر جعبـه  ) kodorat total(بـه نـام كـل كـدورت     خـود را  تغيـر جديـد   مدر اينجـا مـا   

Variable در جعبـه   برابر با مجموع سـه كـدورت  و آن را تعريفNumeric Expression   قـرار

 .كنيم را كليك مي okاتمه خدر  .دهيم مي

قبل از انجـام ايـن كـار يـك بـار      . يديهاي خود را تجزيه و تحليل نما حال شما آماده هستيد تا داده

 .ايد آن را تصحيح كنيد ها داشته اگر اشتباهي در ورود دادههاي خود را مرور كنيد تا  داده

 ها  آزمون نرمال بودن داده

هاي مختلفي بـراي   روش. هاي خود را مورد آزمون قرار دهيم نرمال بودن دادهكه  اولين قدم اينست

باشد كه در زبان فارسي به آن كشيدگي  مي Skewnessيك راه محاسبه . انجام اين كار وجود دارد

بايـد  . نرمال به كدام سمت كشـيده شـده اسـت    از حالت گويند كه به مفهوم اينست كه منحني مي
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گيـرد   قرار مـي به نام منحني نرمال دقت كنيد كه هر چه پروردگار آفريده است بر روي يك منحني 

ز هر د و انگير مي قرار يكديگرباشد و در مركز آن ميانگين، ميانه و مد برروي  كه به صورت قرينه مي

 sd 3± Meanدر مطالعات ايـن مسـئله بـه صـورت     . گردد انحراف معيار جدا مي 3طرف به اندازه 

 .گردد ارائه مي

پرهزينه، وقت گير و در بيشتر مواقع غير ممكن  )سرشماري( با توجه به اينكه بررسي بر روي جامعه

انجام  حيحبا روش ص باشد كه اگر روشي آسان براي بدست آوردن اطلاعات مي ،گيري نمونه. است

 .باشد ميناپارامتريك روش آماري مورد استفاده و پيروي نكرده  توزيع نرمالها از  داده نگيرد

هايش از توزيـع نرمـال پيـروي     داده آيابايد مطمئن شود، ها  محقق بلافاصله بعد از وارد نمودن داده

و  كلمـوگروف اسـميرنوف   زمـون آهاي گرافيكـي،   روشاز يا نه؟ براي انجام اين كار كنند  مي

توجه كند كه فقط يك  بايد محققالبته . استفاده كردتوان  مي آندرسن دارلينگي مانند يها روش

 .باشد هاي فوق كافي مي ها براي نرمال بودن به يكي از روش بار آزمايش داده

نمود  باشد بايد دقت مي زمون كلموگروف اسميرنوفآها در نزد محققين  يكي از محبوبترين روش

كه محقق قبل از اجراي هر آزمون بايد يك فرضيه را در ذهن خود داشـته باشـد كـه از دو قسـمت     

 باشـد مـثلاً   بـودن مـي  برابـر  مبتني بـر   H0تشكيل شده است هميشه فرض  H1و فرض  H0فرض 

س دو باشد و يـا واريـان   ميانگين دو جامعه با هم برابر ميكنند و يا  ها از توزيع نرمال پيروي مي داده

هـا از توزيـع نرمـال پيـروي      داده فرض مخـالف اسـت مـثلاً    دقيقاً H1ولي فرض  .گروه يكسان است

. امعه با يكديگر برابر نيست و يا واريانس دو گروه با يكديگر برابر نيستجكنند و يا ميانگين دو  نمي

فتـه اسـت و   طرفي را در نظر گر هاي فوق محقق جنبه بي توجه شود در كليه فرض H1اگر به فرض 

يـا دو  دو دامنه يم فرض ما يگو استفاده كرده است در اين حالت مي ،برابر نيستاز كلماتي مانند 

ون بيمـاران  خود را به اين صورت بنويسد كه ميانگين قند خ H1است، ولي اگر محقق فرض  طرفه
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 دامنـه يـا يـك    يك طرفهرا  H1بيشتر از ميانگين آن در گروه شاهد است در اين حالت فرضيه 

 .ييمگو مي

اگـر از فرضـيه دو دامنـه    . انتخاب فرضيه به صورت يك طرفه يا دو طرفـه بسـتگي بـه محقـق دارد    

و اگـر از   جـدول دو دامنـه  را بـا  ... و  T ،Z ،Fكنيد بايد نتايج بدست آمده را ماننـد   استفاده مي

 . كنيدمربوطه استفاده  داول يك دامنهجكنيد بايد از  استفاده مي يك دامنهفرضيه 

براي آزمون نرمال بودن . كند دار بودن و يا نبودن آزمايش را براي ما مشخص مي معني spssبرنامه 

زيـر در نـرم افـزار اسـتفاده      از منوهاي .كنيم استفاده مي Uكلموگروف اسميرنوف آزمونUها از  داده

 :كنيد

Analyze>Nonparametric Tests>1-Sample K-S 

 
 :گردد مايان ميزير ن پنجرهبا اجراي آن 
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را تيـك بزنيـد    Normalمربع منتقل كنيد و  Test Variable Listجعبه متغير مورد نظر را به 

 .را كليك كنيد Ok سپس دكمه

 

One-Sample Kolmogorov-Smirnov Test 

  cu 

N 39 

Normal Parametersa Mean 1.0178 

Std. Deviation 5.85823 

Most Extreme Differences Absolute .114 

Positive .114 

Negative -.082 

Kolmogorov-Smirnov Z .714 

Asymp. Sig. (2-tailed) .688 

a. Test distribution is Normal. 
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 688/0دار بودن برابر بـا   و سطح معني 714/0زمون كولموگروف اسميرنوف برابر با آدر اينجا ميزان 

مورد قبول  H0باشد پس فرض  بيشتر مي 0,05بودن از  دار چون سطح معني. ارائه شده است

 .كنند ها از توزيع نرمال پيروي مي باشد يعني داده مي

وريم براي آرا بدست  ها محاسبه چولگي و كشيدگي ميزان نرمال بودن دادهتوانيم از طريق  مي

 :منوهاي زير را دنبال كنيد انجام اين كار مسير

Analyze>Descriptive Statistics>Frequencies 

 
 

 .شود ين قسمت پنجره زير نمايان ميبا وارد شدن به ا
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 Statisticsوارد كرده و بعد با كليك بـر روي دكمـه    Variable جعبهابتدا متغير مورد نظر را در 

بـــا زدن  تيـــك بزنيـــدرا  Kurtosisو  Skewnessدو آيـــتم . شـــود پنجـــره دوم ظـــاهر مـــي

 :گردد زير نمايان ميجدول  Okو   Continueدكمه

cu   

N Valid 39 

Missing 121 

Mean 1.0178 

Std. Deviation 5.85823 

Skewness .513 

Std. Error of Skewness .378 

Kurtosis -.800 

Std. Error of Kurtosis .741 

Percentiles 25 57.5500 

50 95.4000 

75 1.4373 

 

 باشـد كـه   مـي  0,513برابـر بـا    Skewnessو ميـزان   -0,8ابـر بـا   بر Kurtosisدر اينجا ميـزان  

 :گردد به صورت زير تفسير مي هاي مختلف چوگلي و كشيدگي اندازه

 ها به نرمال بودن نزديـك اسـت   يم كه توزيع دادهيگو باشد مي 0,1اگر ميزان هر كدام كمتر از  -الف

)sk( است رمالتوزيع نه اندازه كشيدگي ها ب و كشيدگي توزيع داده .)k( 

 ـ  يم كه توزيـع داده يگو باشد مي 0,5بيشتر ولي كمتر از  0,1از اگر ميزان هر كدام  -ب نرمـال   اهـا ب

 )k(. است تقريبا نرمالها  و كشيدگي توزيع داده )sk(بودن تفاوت كمي دارد 
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فاحشـي  وت نرمال بودن تفا اها ب يم كه توزيع دادهيگو باشد مي 0,5اگر ميزان هر كدام بيشتر از  -ج

 )k(. توزيع نرمال فاصله دارد) بلندي(با كشيدگي ها  و كشيدگي توزيع داده )sk(دارد 

باشد و بـا   هايش نرمال مي شود كه داده زمون كولموگروف اسميرنوف متوجه ميآمحقق با استفاده از 

 تـوان وضـعيت نرمـال بـودن و كشـيدگي را      مي Skewnessو ميزان  Kurtosisميزان  استفاده از

در  Skewnessو تفاوت بـا وضـعيت نرمـال     Kurtosisكشيدگي به يك سمت در . مشخص نمود

 :تواند به علل زير باشد متغير فوق مي

به اشتباه وارد شده اسـت و اعـداد آنهـا بسـيار      ،يك يا چند دادهاطلاعات در موقع وارد كردن  -الف

 .ك كنيدچ را ها باشند در اين وضعيت داده متفاوت با اعداد اصلي مي

درصـد   97فرض كنيـد كـه    باشد مثلاً ها مي ها برخي از متغيرها بسيار زيادتر از ساير داده اندازه -ب

باشند در اين حالت ايـن   1025و  450،  300درصد آنها اعداد  3بوده و  40تا  10هاي ما بين  داده

گـردد   از حالت نرمال ميمتفاوت با ساير اعداد هستند باعث خارج شدن متغير ما  سه عدد كه كاملاً

باشـد شـما    هـاي شـما زيـاد مـي     اگر تعـداد داده . بهتر است اين سه داده را مورد بررسي قرار دهيد

دقت كنيـد در  . نظر كنيد هستند، صرف پرتتوانيد از چند داده كه از اعداد اصلي بسيار دور و يا  مي

آمـار  از  بايـد  را انجـام دهيـد و  توانيـد ايـن كـار     نمـي  هاي شما محدود هستند شما زماني كه داده

 .استفاده كنيد ناپارامتري

هـا   ست كه اقدام به مرتـب كـردن داده  ا باشند كافي ي كه با بقيه متفاوت مييها ي دادهيبراي شناسا

 .يديدر هر ستون نما )نزولي( و يا زياد به كم )صعودي( براساس كم به زياد

 :را انتخاب كنيد زير كليك راست كرده و يكي از دو آيتمروي نام متغير  براي اينكار بر

Set Ascending 

Set Descending 
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در اين فرمـان شـما آمارهـاي    . در اين نرم افزار است Exploreيك راه حل ديگر استفاده از فرمان 

براي اين كار يـك متغيـر   . دهيد يك متغير را بر حسب سطوح يك متغير ديگر مورد بررسي قرار مي

گيريم براي اجراي اين فرمان به  باشد را به همراه يك متغير عامل در نظر مي ابسته را كه كمي ميو

 :صورت زير عمل كنيد

Analyze>Descriptive Statistics>Explore 

 
 :گردد با اجراي فرمان پنجره زير نمايان مي
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و متغير عامـل را كـه در    Dependent List جعبهباشد را در  مي cuمتغير وابسته را كه در اينجا 

وارد  Factor Listمشـخص شـده اسـت در     8تـا   1بـا اعـداد    وباشـد   اينجا منطقه مورد نظر مـي 

 و بـا انتخـاب   شـود  ظـاهر مـي   نوع نمودار مورد نظرپنجره مربوط به  Plotsبا زدن دكمه . كنيم مي

Steam and Leaf      نوع نمودار خود را مشـخص كـرده و پـس از زدن دكمـهContinue و Ok 

 :شود گزارش زير در خروجي ديده مي
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گـردد كـه ميانـه در     شود كه با يك نگاه سـاده مشـخص مـي    گفته مي باكس ويسكرنمودار به اين 

باشيم كه  باشد و ما داراي يك مشاهده پرت مي منطقه سوم و منطقه ششم بالاتر از ساير مناطق مي

. باشـد  مـي  3و شماره داده پـرت   قرار گرفته است 5نطقه باشد و در م ن مشخص ميآشماره رديف 

با حذف مشاهدات بسيار پرت و يا پرت . ممكن است كه محقق داراي مشاهدات بسيار پرت نيز باشد

كنـيم كـه نبايـد در حجـم كـم       بهبود بخشيد و يادآوري مي را ها توان وضعيت نرمال شدن داده مي

 .هاي پرت را حذف نمود داده ،نمونه

 شماره داده پرت 

 بيشترين مقدار

 چارک سوم

 ميانه

چارک 
 اول

 کمترين مقدار
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 هاي مورد نظر ي نمونهررسب

 .كنيم هاي مختلفي انجام گيرد در ذيل موارد مختلف را ذكر مي تواند به صورت تحقيق مي

 مانند ارائه پرسشنامه كيفيت زندگي به بيماران ديابتيك در يك بار -بررسي يك گروه •

ارائـه پرسشـنامه كيفيـت زنـدگي بـه       دمانن -بررسي يك گروه در قبل و بعد از مداخله •

در اينجا كيفيت زندگي را در كل بيماران در بـار  (ران ديابتيك قبل و بعد از مداخله بيما

كيفيـت زنـدگي را    سپس مداخلـه را انجـام داده و چنـد مـاه بعـد مجـدداً      اول سنجيده 

خواهيم تـاثير داروي   دهيم و يا مي سنجيم و آن را براي هر فرد مورد مقايسه قرار مي مي

ون بيماران بسنجيم هر بيمار داراي يك فشار خـون قبـل از   بيهوشي را در ميزان فشار خ

باشد كه مقايسه قبل و بعد هـر بيمـار    از تزريق دارو مي تزريق دارو و يك فشار خون بعد

 .)مدنظر است

بنـدي براسـاس    هاي مختلفي را انجام دهيـد ماننـد دسـته    بندي توانيد دسته براساس نوع مطالعه مي

 ... جنس، شغل و

بنـدي خاصـي ماننـد گـروه      حقق بايد مشخص كند كه آيا داراي دسـته م -ك متغيربندي ي دسته

چون وجود افراد بيشتر از يك دسته مستلزم اينست كه آنها را در نـرم   ؟باشد يا نه شاهد و بيمار مي

ماننـد   ،نـام دلبخـواه   بـا يم براي انجام اين كار بايـد يـك متغيـر جديـد را     يتعريف نما SPSSافزار 

group بدهيم... و 3،  2هاي بعدي عددهاي  و افراد دسته 1كنيم و به افراد دسته اول عدد  تعريف .

هـاي   در مثـال  باشند مثلاً هاي مختلف مورد نياز مي اين دسته بندي در تمام مراحل آناليز بين گروه

 1گيري كرده بوديم كه تحت عنوان منـاطق   منطقه اندازه 8را در  )cu( كه ما مس دقبلي شما ديدي

 .گذاري شده بودند نام 8تا 
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 ها  هترين مرحله در آناليز داد ييابتدا

باشد، اگر كل افـراد مـورد بررسـي در     ها ارائه يك آمار توصيفي از تحقيق مي قدم اول در آناليز داده

يرهـاي مختلـف شـروع    غتوانيم گزارشات آماري خـود را بـا توصـيف مت    يك گروه همگن هستند مي

ايم و در مرحله بعد آنهـا را در   ر يك درمانگاه كل بيماران ديابتيك را در نظر گرفتهما د يم، مثلاًينما

ون كـل افـراد مـورد    چ ـايـم در اينجـا    بندي كـرده  له دستهخدو گروه مورد مداخله و گروه بدون مدا

بايد ابتدا گزارشات آماري خود را بر اساس كل اين افراد  ،باشند بررسي در داشتن ديابت مشترك مي

ي ماننـد  ييرهـا غمحقق مي تواند در اين مرحله با ارائه ميانگين و انحراف معيار براي مت. يميائه نماار

 .اطلاعات مناسبي را براي افراد مورد بررسي فراهم نمايد... ، ميزان قند خون ناشتا و سن

همگـن  ايـد  بدر همه موارد  افراد سالم و افراد بيمار است اين گروه اگر تحقيق شما بر روي دو گروه

يك گروه افراد سالم را به عنوان شاهد و بيماران ديابتيك را  ، مثلاًبيماري مورد نظر به جز در باشند

مثـل سـن ، شـغل و    (يد كه در تمام موارد اين دو گروه همگن هستند ا به عنوان مورد در نظر گرفته
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 اين نوع مطالعاتدر . ا نداردو گروه شاهد اين عامل ر استبيماري ديابت مورد داراي فقط گروه ) ....

 مختلـف افـراد  يرهـاي  غارائه گزارشاتي مانند ميانگين و انحراف معيار كل افراد مورد بررسي براي مت

در زيـر بـه   . شـود لازم نيست، بلكه بايد اين اطلاعات بر اساس هر دسته به صـورت جداگانـه ارائـه    

 .يمبررسي انواع آناليز داده ها در مطالعات مختلف مي پرداز

 :كليه افراد را در يك گروه قرار دادبتوان كه هنگامي ها  دهآناليز اوليه دا -الف

را در  Frequencyهـاي آمـاري شـروع كنيـد يعنـي ميـزان        ترين روش براي انجام اين كار از ساده

 :بدين منظور از منوهاي زير استفاده كنيد. متغيرهاي مختلف مورد سنجش قرار دهيد

Analyze>Descriptive Statistics>Frequencies 

 
مـي بـريم سـپس روي    ) variables(روبـرو   Boxپنجره زير نمايان مي گردد تمام متغيرها را بـه  

 .كليك مي كنيم tatisticsدكمه 
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كنـد همـانطور كـه در تصـوير بـالا ديـده        ها را براي شما مشخص مي چارك Quartilesبا انتخاب 

، Std Deviation ، انحراف معيـار Sum ، جمع كلMode ، مدMedian توان ميانه شود مي مي

 ، كمتـرين ميـزان  Rangenils ، حـدود S.E mean ، خطاي معيار ميـانگين Variance واريانس

Minimum و بيشترين ميزان Maximum مواردي را كه لازم داريد تيك زده و  .را انتخاب نمود

توانيد نمودار مورد نظر را با كليك بر  يدر اينجا م. پنجره قبل برگرديدبه  Continueبا زدن دكمه 

 .انتخاب كنيد Chartsروي دكمه 

 
بـه پنجـره قبـل برگرديـد و      Continue نوع نمودار مورد نظر را انتخاب كرده و با زدن دكمه ادامه

 Display Frequencuدقت كنيد كه با انتخاب . را كليك تا خروجي زير پديدار شود Okدكمه 

Tables  در پنجرهFrequencis جداول مربوطه نيز نمايش داده مي شود. 
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 :براي متغيرهاي كيفي بايد از فرمان زير استفاده كنيد

Analyze>Descriptive Statistics>Descriptives 

 
منتقـل   Variableمتغيرهـا را بـه جعبـه    . گردد مت فوق پنجره زير نمايان ميبا كليك بر روي قس

 .كنيد

 
يك سري از مواردي را كه در فرمـان   Optionsبا كليك كردن دكمه شود  همانطور كه مشاهده مي

Frequency دهـد و يـك سـري از مـوارد ماننـد مرتـب كـردن         شد را به ما ارائه مـي  مشاهده مي

 Descending means و نزولـي  Ascemding means بر حسب صـعودي  ميانگين متغيرها
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خروجـي زيـر    Okو سپس  Continueيك روي مورد نظر با كل قسمتهايپس از انتخاب  .باشد مي

 :شود پديدار مي

 
 .دهد يك گزارش ساده و جامع از متغيرهاي ما را نشان مي ،مواردبينيد كه انتخاب اين  مي

 در يك بررسيهاي مختلف  به تفكيك گروهها  آناليز اوليه داده

مثلا فرض كنيد كه . اب نمايدها را انتخ كار محقق بايد به صورت جداگانه هر كدام از گروه براي اين

خواهيد يك بررسي اوليه بر روي گروه زن و سپس بر روي گروه مرد داشته باشـيد بـراي انجـام     مي

 :بدين منظور از منوهاي زير استفاده كنيد .اين كار ابتدا بايد گروه مورد نظر را انتخاب كنيد

Data> Select Cases 

 



 بهداشت علوم پزشکی و راهنمای گام به گام در تحقيقات  

 

 

76 

زن را بـا كـد يـك و    . ايم صورت مرد و زن تعريف نموده را به sexطور كه مشخص است متغير همان

) و يـا چنـد گـروه بسـته بـه متغيـر      ( ايم براي انتخاب يكي از اين دو گروه نشان داده 2مرد را با كد 

 :گردد پنجره زير نمودار ميكنيم،  را انتخاب مي Select Cases ياها  انتخاب نمونهقسمت 

 
 ،كليك نماييـد  ifكنيد و روي دكمه را انتخاب  If Condition is Satisfiedيتم آدر پنجره اول 

و  =با كليك كردن روي روبرو منتقل كرده و جعبهپنجره دوم نمايان مي گردد متغير مورد نظر را به 

 okگرديم و بـا زدن   به پنجره قبل مي Continueبا زدن  دقرار دهي 1آن را مساوي عدد  1سپس 

 .خورد و در مقابل رديف مردها علامت ضربدر مي گردنند فقط افراد زن انتخاب مي
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و گزارشات خود را تهيـه كنـيم، بـه     دهيم توانيم آناليز اوليه خود را بر روي اين گروه انجام حال مي

رونـد   ،و عوض كردن يك گروه بـه گـروه ديگـر    Select Casesهمين ترتيب با برگشت به فرمان 

 .رسانيم ميدر هر گروه به پايان ها را  آناليز داده

باطي نپس از اينكه محقق نتايج اوليه خود را بر اساس موارد فوق بدست آورد بايد به روش آمار است

 .ها را دنبال نمايد تجزيه و تحليل داده

 

 ها به روش آمار استنباطي تجزيه و تحليل داده

قـدام بـه   ا.... هاي مختلـف ماننـد كـم بـودن بودجـه تحقيـق، امكانـات و         محقق به علت محدوديت

در حقيقت فرض محقق بر اين است كه نمونـه انتخـاب شـده    . نمايد ري از سطح جامعه مييگ نمونه

در آمـار  . دهـد  باشد و نتايج بدست آمده را در نهايت به جامعـه تعمـيم مـي    نمادي از كل جامعه مي

ي تخمـيمن  باشد و بـرا  اي است كه مبتني بر مشاهده نمونه آماري مي اندازه ،آمارهاستنباطي، يك 

اين كار به دو روش انجـام  . گيرد مورد استفاده قرار مي ،يك پارامتر كه مربوط به جامعه آماري است

در هر دو روش . باشد مي آزمون فرضيهو در روش دوم  اي ورد نقطهآبركه در روش اول  شود مي

بـه كـل يعنـي    كه نتـايج آن مـا را    استرسيم كه جزء در حقيقت همان نمونه  ما از جزء به كل مي

 .كند جامعه هدايت مي

 .ود را انتخاب كنيدو بر اساس آن روش آماري خ مشخصرا  مدنظرزير راه  نموداربا توجه به 
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 مقايسه دو گروه براي يك آزمون كه فقط يك بار انجام شده است –حالت اول

گيـرد   ها مابين دو گـروه انجـام مـي    اين آزمون براي بررسي ميانگين. باشد مي Ttestنام اين آزمون 

يـك مثـال در ايـن مـورد     . شـود  صفت مورد بررسـي در دو گـروه بـه صـورت كمـي سـنجيده مـي       

دو گـروه از لحـاظ شـرايط    باشـد،   بندي بيماران به دو گروه بيماران سرطاني و افراد سالم مي تقسيم

فلز روي را در دو گروه مورد  خواهد ميانگين ميهستند و محقق مشابه  كاملاًدموگرافيك با يكديگر 

 :ر اقدام كنيديزمون از مسير زآبراي انجام اين  .بررسي قرار دهد

Analyze>Compare Means>Independent Samples Ttest 

 در چند گروه در دو گروه

T test   ياT Student  
 دانشجويي

 آناليز واريانس يك طرفه 

انجام يك تست در چندين  قبل و بعد يك گروه
 مرتبه براي يك گروه

Paird test    يا
 Repeated زوج Tآزمون 

measurment 

 آزمون تفاوت بين گروهها بر اساس يك يا چند متغير

آزمون يك بار انجام شده است مثلا يك بار توزيع 
 پرسشنامه يا يك بار تست قند خون

چند بار انجام شده است مثلا توزيع چند بار يك 
 پرسشنامه يا چند بار آزمايش قند خون

 تعداد دفعات آزمودنيها
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 :گردد پنجره زير ظاهر مي فرمانپس از اجراي 

 
رد بررسـي قـرار   در دو گروه زن و مرد مورا  BMIخواهيم متغير شاخص توده بدني  در اينجا ما مي

موده و متغير وارد ن Test Variable رهايمتغ جعبهمتغير كمي مورد نظر را به دهيم براي اين كار 

كنـيم سـپس بـا زدن دكمـه      منتقل مـي  Grouping Variableجعبه بندي را به  مربوط به گروه

Define Groups را وارد ود خ ـبنـدي   دسـته  نشود كه در آ يك پنجره مانند شكل بالا پديدار مي
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در اينجا متغيرجنس را به عنوان متغير گروه در نظر گرفته كه مرد را با عدد يـك و زن را   .كنيم مي

 .يمينما ميمشخص  2با عدد 

 بـا زدن  و در پنجره بعدي Continueليد كپس از تعريف دو دسته مورد نظر در اين پنجره با زدن 

 :گردد مي به صورت زير ظاهرها  دادهتجزيه و تحليل  Okكليد 

 

سـطح  شـود در اينجـا    بينيم كه اطلاعات كاملي در مورد دو گروه ارائه مي با توجه به شماي بالا مي

داراي اخـتلاف   ،در دو گـروه  ،دهد كه آيا ميـانگين متغيـر مـورد بررسـي     نشان مي دار بودن معني

ه دو گروه داراي اختلاف يم كيگو باشد مي 05/0ر از تباشد يا نه؟ اگر عدد ارائه شده كم دار مي معني

يم كه دو گـروه فاقـد   يگو باشد مي 05/0و اگر مانند مثال فوق اين ميزان بيشتر از  هستنددار  معني

 :نويسيم اشند براي نوشتن گزارش در آناليز فوق به صورت زير ميب دار مي اختلاف معني

دار  معنـي فاقـد اخـتلاف    ،در بين دو گـروه زن و مـرد   BMI ميانگين شاخص توده بدني

 .دار بودن نيست يا سطح معني Pvalueدقت كنيد در اين موارد نيازي به نوشتن ميزان  .باشد مي

 

 سطح معنی دار بودن

 تعداد

 ميانگين

 انحراف معيار

 خطای معيار 

متغير مورد 
 آزمون

 گروه بندی 
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 مقايسه چند گروه براي يك آزمون كه فقط يك بار انجام شده است –حالت دوم

يـك آزمـون   زماني كه ). ANOVA way One( باشد ميآناليز واريانس يك طرفه نام اين آزمون 

فرض كنيم كـه بيمـاران    .كنيم بار در چند گروه انجام گيرد از اين آزمون استفاده ميفقط براي يك 

 3و گـروه   2ايم و آنها را بـا گـروه يـك، گـروه      بندي كرده به سه گروه دسته BMIرا از نظر ميزان 

ميـزان كلسـترول در بـين ايـن سـه گـروه مـورد        خواهيم يك متغير را مانند  مي. ايم كرده گذاري نام

 .گيرد انجام مي ها داده بودن با فرض نرمال آناليزقرار دهيم اين  بررسي

 :ين آناليز به روش زير اقدام كنيدبراي انجام ا

Analyze>Compare Means>One-Way ANOVA 

 
 :گردد با كليك بر روي اين قسمت پنجره زير ظاهر مي
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وارد  Dependent List متغيرها هجعبو متغير مورد نظر را در  Factorگروه بندي را در قسمت متغير 

 .گردد به صورت زير نمايان ميها  خروجي داده Okبا زدن . كنيم مي

 
دار  داري مابين آنها وجـود نـدارد زيـرا سـطح معنـي      ها نشان داد كه اختلاف معني مقايسه بين گروه

 .بيشتر است 05/0از  623/0بودن يعني 

 يك آزمون كه دوبار انجام شده است مقايسه قبل و بعد يك گروه براي -حالت سوم

گيـريم   در اين آزمون قبل و بعد يـك گـروه از افـراد را در نظـر مـي     . باشد زوج مي Tنام اين آزمون 

خواهيم اثر داروي سولفو نيادوزول را بر روي بيماران مبتلا به  ما مي مثلاً .باشد هاي ما كمي مي داده

ن كراتينين اين بيماران قبل و بعـد از تجـويز ايـن دارو    به همين منظور ميزا. ي كليه بسنجيمينارسا

 :ر را دنبال كنيديبراي انجام اين آزمون مسير ز سنجيم مي

Analyze>Compare Means>Paried Samples Ttest 

 

 سطح معنی دار بودن
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 متغيرهـا  جعبـه گردد، متغيرهاي مـورد نظـر را بـه     يتم فوق پنجره زير نمايان ميآبا كليك بر روي 

Paired Variables كنيدرد وا: 

 
 :گردد روجي به صورت زير نمايان ميخ Okبا زدن دكمه 

 

 نام متغيرها 

 ميانگين در قبل و بعد 
 تعداد

 خطای معيار
 انحراف معيار

 سطح معنی دار بودن
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بعـد   زمان و در 5,75قبل از تجويز دارو برابر با  زمان شود ميزان اين متغير در همانطور كه ديده مي

است پس تفسير مـا   0,0001دار بودن كوچكتر از  باشد و سطح معني مي 7,65از تجويز دارو برابر با 

 :است به صورت زير

و  داشـته  افـزايش  از تجويز دارو نسبت به قبلويز دارو جميزان كراتينين بيماران بعد از ت

نويسيم تجويز دارو در بالا بردن ميزان كراتينين  باشند و يا مي دار مي اختلاف معنيداراي 

 . Pvalue >05/0است دار  در بيماران موثر بوده و معني

دهـد كـه ايـن     نتايج بدست آمده نشان مي: ر آن را نوشتتوان تفسي يا به اين صورت هم مي و

 . Pvalue >05/0گردد  در بيماران ميميزان كراتينين اعث افزايش دارو ب

 

 در چند بار براي يك گروه متغير كمي گيري يك  حالت چهارم اندازه

ك هرگاه محقق يك آزمون را چند بار در ي .باشد مي Repeated Measurement نام اين آزمون

 3بيماران را در  HbA1cفرض كنيد كه ميزان  مثلاً. كنيم زمون استفاده ميآگروه انجام دهد از اين 

 3، يعني هر بيمـار  ايم مورد سنجش قرار داده )ماه بعد و شش ماه بعد 3د به طرح، وموقع ور(مرتبه 

ي ايـن دوران  در ط ـ HbA1cخواهيم ببينيم كه آيا تفاوتي در ميـزان   مي. داده استمرتبه آزمايش 

سـت  ا ناليز واريانس يك طرفه در ايـن آزمون با آيد كه فرق اين ي؟ دقت فرمابدست آمده است يا نه

يك گـروه  روش در سنجيم و در اين  در چند گروه مي ادر آناليز واريانس يك آزمون ركـه  

 :اين آزمون مسير زير را دنبال كنيدبراي انجام . كنيم چند بار يك آزمون را تكرار مي

 

Analyze>General Linear Model>Repeated Measures 
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در جعبه اول يك نـام عمـومي بـراي متغيـر     . گردد پس از ورود به اين قسمت پنجره زير نمايان مي

وارد  levels of Numberتعداد دفعـات آزمـايش را در جعبـه     سپس Factor1تايپ كنيد مثلاً 

بـه پنجـره    Defineبوطه وارد، سپس بـا زدن دكمـه   آن را به جعبه مر Addكرده و با زدن دكمه 

 .بعدي برويد
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 شود، ابتدا متغيرهاي مورد نظر را به جعبه روبرو برده، ديده مي زيرهمانطور كه در پنجره 

 
 كليك كرده آنرا به باكس  1factorبر روي كلمه  به پنجره بعدي برويد Plotsسپس با زدن دكمه 

AxisHorizontal ن دكمه برده و با زدAdd  ان را به باكسplots منتقل كنيد. 

 
 .گرديد به پنجره قبل برمي Continueبا زدن دكمه 
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ليـك كنيـد   ك Optionها را دو بدو با يكديگر مقايسه نمايد بر روي دكمه  گروه ،افزار براي اينكه نرم

 :تا صفحه زير نمايان شود

 
روبـرو   جعبـه را بـه   Factorمتغير  ر شدههمانطور كه در شكل بعدي ديده مي شود در پنجره ظاه

بـه   Continueو زدن دكمه  Compare Main Effects مربوط به مربعبرده و با زدن تيك در 

  مي گرديمپنجره قبل 
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 :مي گردد تجزيه و تحليل به صورت زير در خروجي ظاهر Okبا زدن دكمه  

 
 :شود يبه صورت زير نمايش داده مها  در صفحه دوم آناليز داده

 

ظر که در سه متغير مورد ن
 بار اندازه گيری شده است 

جواب بر اساس 
 آزمونهای چند متغيره

سطح معنی دار بودن بر 
 اساس هر آزمون

سطح معنی دار بودن که به آن استناد می کنيم چون پس 
 از تصحيحات لازمه توسط نرم افزار ارائه می گردد
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 )شكل زير(گردد  ها نيز ارائه مي ها بر اساس مقايسه دو بدو بين گروه در صفحه سوم آناليز داده

 
در جدول دوم در . بينيم ميميانگين و انحراف معيار را براي يك آزمون در سه مرحله  ،فوقشكل در 

شـود   همانطور كه مشـاهده مـي   .شود ديده ميزمون بعدي آمابين هر آزمون با دو هر رديف مقايسه 

نشـان  هـا   مقايسـه مـابين گـروه    .Pvalue=005/0باشـد   دار مي معنيآزمون در سه مرحله مقايسه 

. Pvalue=051/0شـود   داري بين آزمايش در بار اول و بار سوم ديـده نمـي   تفاوت معنيكه دهد  مي

در اينجا بـر اسـاس ميـانگين     شود زمايش متوالي نشان داده ميآدر صفحه آخر گراف مربوط به سه 

 .گردد نمودار ترسيم مي ،هر بار آزمايش

  سومبار در آزمايش 

  دومبار در آزمايش 

ار اول بدر آزمايش   

و خطای معيار در سه بار يک ميانگين 
 آزمون

سطح معنی دار بودن بين 
  ۳و ۱گروه 

سطح معنی دار بودن بين 
  ۲و ۱گروه 

مقايسه بين يک گروه با دو 
گروه ديگر مثلا در اينجا 

و  ۲و  ۱مقايسه بين گروه 
انجام گرفته است  ۳و  ۱گروه 

دو رديف ديگر هم به همين 
 ترتيب می باشند



 بهداشت علوم پزشکی و راهنمای گام به گام در تحقيقات  

 

 

90 

 

 زمون در يك بار و مقايسه آن با يك مقدار خاص آاندازه گيري يك  -حالت پنجم 

گيـرد كـه محقـق     اين آزمون در زماني انجام مي .باشد مي Test T Sample Oneنام اين آزمون 

خواهـد نتـايج    دهـد و مـي   يك بار در يك گروه انجام مـي را  ) يا توزيع يك پرسشنامه(يك آزمايش 

 ،به يك جامعه يا يك تحقيق كـه در سـطح گسـترده انجـام شـده      بدست آمده را با اطلاعات مربوط

كنيـد،  ارزيـابي  توانيد نتايج خود را با هر تحقيـق ديگـري    بايد دقت كنيد كه شما نمي. مقايسه كند

ي باشد و بتـوان نتـايج آن را مشـابه بـا     يارزش علمي بالا جهت اين كار بايد تحقيق مورد نظر داراي

بـا حجـم    در حقيقت محقق با استناد به چنين تحقيقي كه معمـولاً . دانستاصل در جامعه حنتايج 

 .پردازد ميمطالعه خود ، به ارزيابي استام گرفته جدر ساير نقاط اننمونه بالا
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در اينجا فـرض  . زند در جامعه حدس مي يك راه ديگر اينست كه محقق ميانگين يك صفت كمي را

H0  ميانگين مربـوط بـه يـك    (اينست كه ميانگين بدست آمده در اين بررسي با ميانگين مورد نظر

آن اخـتلاف  دار بـودن   دلالت بر معنـي  H1مساوي باشد و فرض ) تحقيق و يا حدس ما در مورد آن

   :براي انجام اين آناليز مسير زير را دنبال كنيد. دارد

Analyze>Compare Means>One Sample T Test 

 
 مفـروض عدد  متغير موردنظر را به جعبه روبرو ببريد و گردد با ادامه مسير فوق پنجره زير ظاهر مي

و با  تايپ كنيدمانند شكل زير  Test Valueدر جعبه در نظر گرفته شده است  50را كه در اينجا 

 .خروجي را بدست آوريد Okزدن 
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 :گردد ها به صورت زير نمايان مي ادهخروجي د

 
داري بين ميانگين اين بررسي بـا عـدد بدسـت آمـده از      شود اختلاف معني همانطور كه مشاهده مي

يم يگو گردد و مي ما در اينجا قبول مي H0 فرض. شود ديده نمي) يا عدد مفروض محقق(ساير نتايج 

يـادآوري  . نـدارد ) يا ميانگين مفروض(ين جامعه ميانگين بدست آمده در اين بررسي تفاوتي با ميانگ

 .گرفته شده باشدگردد كه بهتر است عدد مورد مقايسه از يك مطالعه بالاي علمي  مي

 ها به روش آمار ناپارامتريك دادهه مقايس

 :كنيم در موارد زير از آمار ناپارامتريك استفاده مي
 .باشدي يفدر صورتيكه متغير ما ك -1

 .از توزيع نرمال پيروي نكنداشند ولي هاي ما كمي ب داده -2

اين مسئله به ويژه در موقعي كه حجم نمونه . ها كمي باشد ولي تعداد نمونه كم باشد داده -3

 .باشد اجباري مي) نمونه 6كمتر از (بسيار كم است 

را هاي ناپامتريـك   شماي زير آزمون. ها ندارند ودن دادهبهاي ناپارامتريك نيازي به فرض نرمال  زمونآ

 .نباله آن به بررسي هر كدام خواهيم پرداختددهد كه در  نشان مي

 سطح معني دار بودن 
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باشـد و در آن نيـازي بـه فـرض      مـي  ANOVA اين آزمون در مقابل -آزمون كروسكال واليس

 .ايـم  تقسـيم كـرده   BMIبيماران را به سه گروه بر اساس ميـزان  بطور مثال . باشد توزيع نرمال نمي

توانيم از آناليز  به همين علت ما نمي ،دنكن ها از توزيع نرمال پيروي نمي دادهدهد كه  نتايج نشان مي

كروسكال واليس است براي انجام ايـن آزمـون    ،زمون آماري ماآواريانس يك طرفه استفاده كنيم و 

 :مسير زير را دنبال كنيد

Analyze>Nonparametric Tests>K Independent Samples 

 آزمون ناپارامتريك

ونه ها مستقل از همنم نمونه ها غير مستقل از هم  

 سه گروه دو گروه

 اسكوراك
 داده ها كيفي 

كروسكال 
 واليس 

 ناپارامتري(
Anova( 

 زمون ميانهآ

 دو گروه سه گروه

 آزمون علامت
اندازه گيري يك 
صفت بر اساس 

و منفي (+) مثبت 
 )- (  

 مك نمار 
 زوج  Tناپارامتري 

 ورود داده ها به صورت صفر و يك 

 زمون فريدمنآ
اندازه گيري 
يك صفت در 
چند مرتبه و 
نوع داده ها 

  رتبه اي 

 آزمون كوكران
اندازه گيري 
يك صفت در 
چند مرتبه بر 
اساس صفر و 

 يك 

 ويلكاكسون
زوج  Tناپارامتري 

هم رتبه و هم 
 علامت مطرح است

كولموگروف 
 اسميرنف

 

 من ويتني 
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 Test Variable Listمتغير موردنظر را بـه جعبـه   . گردد با اجراي اين فرمان پنجره زير ظاهر مي

 .ببريد Grouping Variableبندي را به  منتقل كنيد و متغير گروه
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در . تعريـف كنيـد   بنـدي  گـروه ميزان حداقل و حداكثر را براي متغير  Define Rangeدر قسمت 

گردد بـا زدن دكمـه    مي 3و حداكثر ميزان برابر با  1باشيم حداقل ما  مياينجا چون داراي سه گروه 

Continue مربع . به پنجره قبل باز گرديدKruskal-Walis     را تيك بزنيـد بـا كليـك رويOk 

 :گردد خروجي برنامه به صورت زير نمايان مي

 
مـورد قبـول     H1و فـرض  باشـد  دار مي سه گروه داراي اختلاف معنيدهد كه  نتايح آماري نشان مي

 )Pvalue=0.004. (گردد واقع مي

 ها  ميانگين رتبه

 دار بودن سطح معني
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 آزمون مك نمار

ها را به صورت صفر و يـك وارد   باشد در اين آزمون داده زوج مي tآزمون  ،اين آزمون فرم ناپارامتري

محققي درصدد است تا تاثير يك پيـام بهداشـتي را دربـاره اسـتفاده آقايـان از      بطور مثال، كنيم  مي

نفر  45بسنجد براي همين ) به جاي استفاده بانوان آنها از قرص(گيري از بارداري كاندوم جهت پيش

 هاي شهري مراجعه كرده بودنـد بـه   هايشان را كه به درمانگاه از آقايان مراجعه كننده به همراه خانم

نفر با استفاده كردن از كانـدوم موافـق و    17صورت سرشماري در يك روز انتخاب نمود از اين عده 

نفر مخالف بودند سپس يك فيلم آموزشي در مـورد مزايـاي اسـتفاده از ايـن وسـيله و مضـرات        28

نان پرسش گرديد در اينجـا  آپس از فيلم مجددا از  شدهاي ضدبارداري براي آنان نمايش داده  قرص

دند نفر همچنان موافق و دو نفر عقيده خود را تغيير داده بو 15نفر گروه اول كه موافق بودند  17از 

نفر همچنان مخالف بـاقي مانـده بودنـد     16نفر موافق و  12نفر گروه دوم كه مخالف بودند  28و از 

 ؟باشد كه آيا اين فيلم آموزشي داراي تاثير مثبت بوده است يا نه حال اين سئوال مطرح مي

زشي ما براساس تاثير داشتن اين فيلم آمو H1ما براساس تاثير نداشتن سخنراني و فرض  H0فرض 

 .باشد ميدر تغيير نگرش افراد 

در اينجا دو متغير داريم كه يكي نظر مراجعه كنندگان را قبل از فـيلم آموزشـي ثبـت كـرده اسـت      

)moafegh (دهد  و ديگري نظر آنها را بعد از فيلم آموزشي نشان مي)mokhalef (ها در هـر   داده

 .اند دو متغير به صورت صفر و يك وارد شده

  نياز سخنرابعد 

 مثبتنظر  منفينظر 

 )نفر  17(از سخنراني قبل نظر مثبت  نفر بعد از سخنراني 15 نفر بعد از سخنراني  2

  )نفر 28(از سخنراني قبل نظر منفي  نفر بعد از سخنراني 12 نفر بعد از سخنراني 16
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 :ين آزمون مسير زير را دنبال كنيدبراي انجام ا

Analyze>Nonparametric Tests>2 Related Samples 

 
 :گردد پس از اجراي فرمان فوق پنجره زير نمايان مي
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 Okرا تيـك بزنيـد و روي    McNemarببريد و مربع  Test Parsمتغيرهاي موردنظر را به جعبه 

 :شود فرمان فوق خروجي زبر ديده ميبا اجراي . كليك كنيد

 
 

. اسـت مـورد قبـول    1Hو فـرض   داشـته ير بينيم كه فيلم آموزشي تـاث  با توجه به جواب حاصل مي

)(Pvalue=0.013 

 علامتآزمون 

فـرد مـورد بررسـي قـرار     يـك  باشد و دو متغيـر را در   زمون براي بررسي بر روي يك گروه ميآاين 

خواهيم تاثير اين  مي .استحساسيت بهاره مورد استفاده  در  Bو  Aدو قطره چشمي دهيم مثلاً مي

نفر را كـه بـه حساسـيت بهـاره مبـتلا بـوده        27ابتدا  .جش قرار دهيمدو قطره را همزمان مورد سن

. شوند كه قرمزي در هر دو چشم آنها يكسان باشـد  اين افراد به صورتي انتخاب مي. كنيم ميانتخاب 

ريزيم پس از پنج دقيقـه   را مي B و در چشم چپ اين افراد قطره  Aدر چشم راست اين افراد قطره

 سطح معني دار بودن 
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خواهيم  ها و اينكه در كدام چشم ريخته شده است، مي از نوع قطرهاطلاع  يبچشم پزشك كه  دواز 

كنيم ارزيابي كيفـي مـا بـه صـورت زيـر       فرض مي. دنثبت كنجداگانه كه ميزان قرمزي هر چشم را 

 :باشد مي

 .باشد چشم راست از چشم چپ كمتر ميقرمزي در  -الف

 .باشد قرمزي در چشم چپ از چشم راست كمتر مي -ب

 .ن قرمزي در هر دو چشم فرقي ندارداميز -ج

كمتر بودن قرمزي در چشم راست ( يكتر ما داراي سه نوع داده هستيم كه آنها را با  به عبارت ساده

يكسـان  (سـه  و ) كمتر بودن قرمزي در چشم چپ نسبت به چشم راست( دو، )نسبت به چشم چپ

هـا يـك سـتون را بـراي      داده بـراي وارد نمـودن  كنـيم   دسته بندي مـي ) بودن قرمزي در دو چشم

هاي مربـوط بـه چشـم     و ستون ديگر را براي داده test1به عنوان متغير  اطلاعات يك چشم پزشك

 :دهيم اختصاص مي test2به عنوان متغير  پزشك دوم

 

 

 

 

 

 

 

 :كنيم آزمون مسير زير را دنبال ميبراي انجام اين 

Analyze>Nonparametric Tests>2 Repeated Samples 

زوج در اين است كه هر دو آزمـون قبـل و    tتشابه اين ازمون با 
وج در ايـن  ز tتفاوت اين ازمـون بـا   . سنجند بعد يك گروه را مي

سـنجيم و   است كه ما دو متغيـر مسـتقل را در سـه حالـت مـي     
باشند در حاليكه  ها دو نفر مي مشاهده گرهاي ما براي ثبت داده

سـنجيم و   زوج ما يك متغير داريم و آن را در دو حالت مي tدر 
 .باشد گر يك نفر مي مشاهده
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هـاي هـر يـك از دو چشـم      متغيرهاي مربوط بـه داده . گردد با ادامه مسير فوق پنجره زير ظاهر مي

 .را تيك بزنيد signببريد و مربع مربوط به  test pairsپزشك را به جعبه 
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درخواسـت كنيـد تـا     Descriptivesبا تيـك زدن مربـع    توانيد مي Option با كليك روي دكمه

خروجي زير نمـايش   Okو  Continueوصيفي را نيز ارائه دهد با زدن دكمه خروجي برنامه آمار ت

 :شود داده مي

 
و  Pvalue < 0.001باشـند   دار مـي  باشد دو گـروه داراي اخـتلاف معنـي    همانطور كه مشخص مي

 .گردد صفر ما رد مي  H0باشد و فرض بهتر مي B از قطره A ميزان تاثير قطره

 مجموع تغييرات در چشم راست و چشم چپ

تعداد افرادي كه قرمزي در هر دو چشم 
 آنها فرقي نكرده است 

 سطح معني دار بودن
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 .دهد مي اننشپزشك اول چشم  توسطهاي مورد بررسي را نمودار فوق ميزان فاكتور
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 .دهد نشان مي پزشك دومچشم  را توسطاين نمودار ميزان فاكتورهاي مورد بررسي 
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 دار آزمون ويلكاكسون علامت

اين آزمون در حقيقت يك آناليز آماري مشابه با آزمون علامت مي باشد در اين آزمون هم علامت و 

ها را در نظر مي گيريم در آزمون علامت ما فقط علامت ماحصل از رتبه ها را  هم تفاوت مابين رتبه

بـراي انجـام آزمـون    مثال قبل را با آزمون ويلكاكسون علامت دار آناليز مـي كنـيم    .در نظر گرفتيم

 :ديمسير زير را دنبال كن

Analyze>Nonparametric Tests>2 Related Samples 

 
ببريـد و مربـع    Test Pairsمتغيرهـا را بـه جعبـه     .گـردد  ير ظاهر مـي با اجراي اين مسير پنجره ز

Wilcoxon را تيك بزنيد. 
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 :گردد خروجي زير ظاهر مي okبا زدن 

 
دار  بينـيم كـه دو گـروه داراي اخـتلاف معنـي      براساس آناليز با آزمون علامـت دار ويلكاكسـون مـي   

 .گردد صفر رد مي H0فرض  وباشند  مي

 سطح معني دار بودن
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يك پرسشنامه اند را با  قق ميزان افسردگي را در كشاورزاني كه بر روي مين رفتهيك مح -مثال دوم

باشـد در   مـي  9تـا   1هـا بـين    دهد كه اين رتبه سنجيده و بر اساس كليد استاندارد به آنان رتبه مي

براي همين با استفاده از امكانات  برند، رنج ميشود كه افراد فوق از فقر مالي  حين بررسي متوجه مي

گمـارد پـس از گذشـت شـش مـاه       ي آنان مـي يموجود هر كدام از اين افراد را به كاري در حد توانا

خواهد بداند آيـا   دهد حال مي هاي جديد را به افراد مي كند و رتبه تست را تكرار مي مجدداً ،مراجعه

زان رتبه فـرد  به كار گماري اين افراد در كاهش افسردگي آنان موثر بوده است يا نه در اينجا اگر مي

گيـرد و نـوع علامـت او در     دو نمره كاهش رتبـه مـي  رسيده باشد  5به  7از  كاهش يافته باشد مثلاً

گيـرد و نـوع علامـت او     فرد دو رتبه مـي رسيده باشد  8به  6از  و اگر مثلاًاست علامت منفي اينجا 

هـا   آناليز داده .باشد زمون هم كاهش رتبه افسردگي و هم علامت آن مدنظر ميآدر اين . است مثبت

 :نشان داد آزمون علامت بر اساس

 

 دار بودن سطح معني
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تـاثيري  و به كارگماري ايـن افـراد در كـاهش افسـردگي آنـان      مورد قبول است  H0در اينجا فرض 

 .نداشته است

 .دهيم را براي حل اين مسئله مورد استفاده قرار مي دار آزمون ويلكاكسون علامت

 
ود آنان و به كار گماري اين افراد تاثيري در بهب استبل قبول قا نيزدر اينجا  H0بينيم كه فرض  مي

 .از افسردگي نداشته است

 دار بودن سطح معني
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 كراناآزمون ك

و مانند آزمون مك نمار قبل و بعد گيريم  اين آزمون ما يك صفت را در چندين حالت در نظر مي در

در طول چهـار   صيمشخر يك داروي اشتهاآور را بر افراد ثخواهد ا كنيم محققي مي نداريم فرض مي

هفته مورد بررسي قرار دهد براي انجام اين كار او به صـورت هفتگـي بـا بيمـاران تمـاس حاصـل و       

وضعيت آنان را به صورت داشتن اشتها و نداشتن اشتها ارزيابي نموده است در ايـن حالـت داشـتن    

او بـر عـدم    H0اشتها را معادل عدد يك و نداشتن آن را معادل عدد صفر در نظر گرفته است فرض 

نفـر   26باشد تعـداد افـراد مـورد مطالعـه      او برداشتن تاثير براي اين دارو مي H1تاثير دارو و فرض 

به صـورت   test1, test2, test3,test4در متغيرهاي  هاي فوق باشد اطلاعات ما در طول هفته مي

 .براي انجام اين آزمون مسير زير را دنبال كنيد. است صفر و يك ثبت شده

Analyze>Nonparametric Tests>KRelated Samples 
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متغيرهـاي مـوردنظر را بـه جعبـه روبـرو و مربـع        .گـردد  با انجام مسير فوق پنجره زيـر ظـاهر مـي   

Cochran's Q را تيك بزنيد. 

 
 :گردد خروجي زير نمايان مي Okكليك روي با 

 

 دار بودن  سطح معني
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 يا نه؟ر مشابه داشته است محقق اين است كه آيا اين دارو در طول چهار هفته تاثي سوال

مـورد قبـول     H0باشـد و فـرض   هاي مختلف يكنواخت مي بينيم كه تاثير دارو در هفته در اينجا مي

 .باشد مي

بايد متغيرها را دو بدو مورد بررسي قرار دهـيم در   .مورد قبول قرار گيرد 1Hاگر در بررسي ما فرض 

 -قايسه وجود دارد كه شـامل هفتـه اول و دوم  حالت م 6باشيم پس  هفته مي 4اينجا چون ما داراي 

هفتـه سـوم و چهـارم     -هفته دوم و چهارم -هفته دوم و سوم -هفته اول و چهارم -هفته اول و سوم

و چـون داراي شـش حالـت    كنـيم   استفاده مي آزمون مك نماراز است براي مقايسه هر كدام 

در نظر بگيـريم   0,05برابر با ا ر  αاگر .را بر عدد شش تقسيم كنيم αباشيم بايد ميزان  مي

 .گردد مي 0,01تقريبا معادل با ها  پس عدد مبنا ما براي تحليل داده

 .توانيم فرضيه خود را در بين هر دو هفته بررسي كنيم بدين ترتيب مي

 فريدمنآزمون 

در ايـن آزمـون    .باشـد  مـي  Repeated Measurmentآزمون فريدمن معادل ناپارامتري آزمـون  

ر روي بيماران قطـع  بمحققي  شوند مثلاً باشد و در چند حالت سنجيده مي اي مي ي ما رتبهمتغيرها

خواهد اثر يك داروي جديد در كاهش درد را به مـدت چهـار    كند و مي عضو در ناحيه پا تحقيق مي

كنـد و در پايـان    هفته پس از قطع عضو در فرد بسنجد براي اين كار يك نمودار مانند زير تهيه مـي 

ميزان درد را با اسـتفاده  خواهد تا كند و از او مي هفته از بيمار در مورد وضعيت درد او سئوال مي هر

تـوان   با گذاشتن اين نوار بر روي يك خط كش مـي . گذاري كند ر زير بر روي صفحه علامتاز نمودا

 مربوطه را مشخص نمود،  دعد

 

10          9          8          7          6           5          4          3           2            1           0 
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متغيـر   4هـا در   داده :گـردد  يـر تهيـه مـي   اطلاعات خام مـا بـه صـورت ز    ،ها آوري داده پس از جمع

Week1, Week2, Week3, Week4  مي كنيمثبت  نهبه صورت اعداد يك تا. 

 :براي انجام آزمون فريدمن مسير زير را دنبال كنيد

Analyze>Nonparametric Tests>K Related Samples 

 

 :گردد پس از اجراي فرمان فوق پنجره زير نمايان مي
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خروجـي زيـر    Okبـا زدن   .را تيك بزنيد Friedmanمربع  روبرو منتقل كرده جعبهبه متغيرها را 

 :گردد نمايان مي

 

عنی دار بودن سطح م  
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داري وجـود   ها از لحاظ درد در بيماران تفاوت معني بين هفتهدهد كـه   ميها نشان  آناليز داده

آزمون ويلكاكسون بـراي سـنجش دو بـدو    قابل قبول است در اين حالت از  H1و فرض  دارد

 .كنيم استفاده مي ها تههف

 
مرحلـه   6مقايسات ما در  .كنيم وارد مي )به صورت جداگانه( مربوطه جعبهتمام حالات موجود را در 

بـه   باشـد  مـي .... هفته اول و چهارم و  -هفته اول و سوم -كه شامل هفته اول و دوم،گردد ميتعريف 

خروجـي مـا بـه صـورت زيـر       Okبـا زدن   .عنوان مثال آزمون را براي هفته اول و دوم انجام داديم

 :گردد نمايان مي

 

 دار بودن سطح معني
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و دارو در بين است قابل قبول  H1فرض دهد كه  مينتايج آماري مابين هفته اول و هفته دوم نشان 

 .دهيم ها را انجام مي ن ساير هفتهبه همين ترتيب مقايسه بيهفته اول و دوم تاثير داشته است 

 وريا كا اسككاي دو يا خي دو آزمون 

بيمـار را بـا روش الـف و     35را در نظر گرفته است و  Bو  Aيك جراح براي عمل جراحي دو روش 

بيماري كه به روش الـف مـورد معالجـه قـرار      35دهد از  بيمار را با روش ب مورد عمل قرار مي 45

 Bو  Aروش  اند آيا بين بيمار بهبود يافته 27بيمار گروه ب  45بيمار بهبود يافته و از  17اند  گرفته

بـه صـورت صـفر و يـك ثبـت       Surjery2, Surjery1ها در دو متغيـر   داده ؟اختلافي وجود دارد

 .اند شده

 :زير را دنبال كنيد براي انجام آزمون مسير

Analyze>Non Parametric Tests>Chi-Square 
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 .متغيرها را به جعبه روبرو ببريد .گردد با ادامه مسير فوق پنجره زير نمايان مي

 
يد يدرخواست نما Optionدر قسمت  دتواني شما مي. شود ميخروجي زير پديدار  okبا زدن دكمه 

 .ها را نيز به نمايش در آورد افزار آمار توصيفي و چارك نرم

 

 سطح معني دار بودن 
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يعنـي فـرض    .باشند دار مي با يكديگر مشابه و فاقد اختلاف معنيروش كه دو  دهد ميبررسي نشان 

H0 شود پذيرفته مي. 

 Binomialباينوميال  تست

 H1ما دلالت بر مساوي بودن دو نسبت و فرض  H0در اين آزمون ما داراي دو نسبت هستيم فرض 

 .دلالت بر متفاوت بودن دو نسبت دارد

مشخص  گيري در يك بررسي كه بر روي دانشجويان پزشكي انجام گرفته است پس از نمونه

باشند  درصد دانشجويان پسر مي 40ويان دختر و دانشج ،هاي انتخابي درصد نمونه 60كهگردد  مي

توانيم در اين بررسي يكسان فرض كنيم  جويان پسر و دختر را مييا تعداد دانشآ ،خواهيم ببينيم مي

 يا نه؟
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هاي مختلف انجام دهيم  توانيم مواردي را مانند مقايسه نسبت مياي  ملهجيا دو  در آزمون بينومينال

براي ). 2كد(بودنغير بومي و ) 1كد(بومي بودن يا ) 2كد(و بالاي ديپلم ) 1كد(ر ديپلم يزمانند 

 :اجراي آزمون مسير زير را دنبال كنيد

Analyze>Nonparametric tests>Binomial 

 Test Proportion آزمـون نسـبت  گردد در قسمت مربوط به  پس از اجراي فرمان فوق صفحه زير نمايان مي

در مواردي كه نسـبت  . در نظر بگيريم 0,5توانيم آن را برابر با  كه ميكنيد  تايپرا  مورد نظر نسبت

در ايـن قسـمت مـا     .توانيم نسبت خود را با آن مطالعات مقايسه كنيم يم ميردا را از مطالعات ديگر

ايم و فرض ما اينست كه نسـبت زن و مـرد بايـد مسـاوي و      را مورد سنجش قرار داده متغير جنس

 5/0عدد ) Test Proportion نسبت آزمون(د به همين علت در اين قسمت درصد باش 50برابر با 

 .ايم را وارد نموده

 
 .كليك كنيد Okمتغير موردنظر را به جعبه روبرو ببريد و روي 

 .گردد پس از اجراي فرمان فوق خروجي به صورت زير نمايان مي
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 .استقابل قبول  H1در اينجا فرض . ددارندار  معني اختلاف بينيم كه دو نسبت برابر نيست و مي

 Runsآزمون 

تصـادفي  از اين آزمون براي بررسـي   .ها شرط تصادفي بودن مشاهدات لازم است در خيلي از آزمون

خواهيم ببينيم كه شرط تصـادفي   مي مثلاً .گردد استفاده ميها، در متغيرهاي دو وضعيتي  بودن داده

براي اجراي آزمـون   رعايت شده است يا نه؟ ضعيت اقامتوبودن بومي و غير بومي بودن در متغير 

  Analyze>Nonparametric Tests>Runs                             :مسير زير را دنبال كنيد

 
 .گردد پنجره زير نمايان ميبا اجراي فرمان فوق 

 سطح معني دار بودن 

 نسبت مرد  زن نسبت 
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و  Median منتقـل كـرده و دو آيـتم ميانـه     Test Variable Listمتغير مورد نظر را به بـاكس  

 :گردد خروجي زير نمايان مي Okكليك روي يم، با ينما را انتخاب مي Meanميانگين 

 

 zميزان 

دار  سطح معني
 بودن
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يعني شرط تصادفي بودن در وضعيت اقامت رعايت ) Pvalue<0/0001(شود  رد مي H0فرض 

 .نشده است

 آزمون من ويتني

 :ا دنبال كنيدباشد براي انجام آزمون مراحل زير ر مي T testاين آزمون فرم ناپارامتري 

Analyze>Non parametric Tests>2 Independent Samples 

 
 Test variable list جعبهگردد متغير مورد نظر را به  با اجراي دستور فوق پنجره زير نمايان مي

بندي بر اساس آن انجام  متغيري را كه دسته Grouping variable جعبهمنتقل كرده و در 

باشد از توزيع  كه يك متغير كمي مي BMIاينجا فرض ما اينست كه متغير  در. كنيدگيرد وارد  مي

خواهيم اين متغير را در بين دو جنس زن و مرد مورد مقايسه قرار  نرمال پيروي نكرده است و مي

كليك  Define Groupsروي دكمه . ايم ص نمودهمشخ 2مرد را با عدد يك و زن را با عدد .دهيم 

را وارد كنيد و روي  2عدد  Group2عدد يك و در جعبه  Group1كنيد و در جعبه 

Continue سپس مربع . كليك كنيدMann-Whitney  را تيك بزنيد و رويOk كليك كنيد. 
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 :گردد با اجراي فرمان خروجي زير نمايان مي

 
دار  در بين زن و مـرد متفـاوت و داراي اخـتلاف معنـي     BMIكه ميزان گردد  در اينجا مشخص مي

 )Pvalue<0.001( .باشد يم

 دار است معني
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 Moses extreme reactionsآزمون موسي 

درصد از  5 اين آزمون .كنيم وقتي مشاهدات خيلي پرت باشد از آزمون موسي استفاده مي

براي . دهد نمايد و سپس آناليز را انجام مي ميذف حين را يدرصد از مشاهدات پا 5مشاهدات بالا و 

 :كنيدام آزمون فرمان زير را اجرا انج

Analyze>Nonparametric Tests>2 Independent Samples 

 
 Test Variable Listمتغير مور نظر را به جعبه گردد  پس از اجراي فرمان صفحه زير نمايان مي

بـا   زمـون موسـي را  آ، منتقل كنيد سـپس  Grouping Variableبندي را به جعبه  و متغير گروه

 .كليك كنيد Okنماييد و روي انتخاب  Moses Extreme Reactionتيك زدن مربع 
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 .گردد با اجراي آزمون خروجي زير نمايان مي

 
را با فرض نرمـال نبـودن در بـين دو جـنس زن و مـرد       BMIهمانطور كه مشخص است ما متغير 

نتايج براساس آزمـون مـن ويتنـي نشـان داد كـه      . ايم براساس آزمون من ويتني و موسي انجام داده

 دار بودن سطح معني

 دار بودن سطح معني
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داراي  BMIدار است ما بـا فـرض اينكـه متغيـر      متفاوت و معني ،در بين دو جنس BMIن ميانگي

درصـد آنهـا را در    5هـا را در بـالا و    درصد داده 5با استفاده از آزمون موسي باشد  هاي پرت مي داده

درصد  5ها به صورت نزولي  نرم افزار پس از مرتب كردن داده. (ايم ين حذف و آناليز را انجام دادهيپا

همـانطور كـه در شـماي بـالا ديـده      ). دهد ها را از بالا و پائين حذف و سپس آناليز را انجام مي داده

 .شود بين دو جنس با آزمون موسي ديده نمي رد BMIداري بين ميزان  شود تفاوت معني مي

 همبستگي و آزمون رگرسيون

ا افزايش قد انتظـار داريـم ميـزان وزن    ب دهد مثلاً نحوه ارتباط بين دو متغير را نشان مياين آزمون 

 .يابد افزايش يابد و يا با افزايش وزن ميزان قدرت جسماني فرد در دويدن كاهش مي

مقياس آنها نسبتي و يـا  گيرد كه  انجام ميبين دو متغير كمي فقط به كارگيري همبستگي پيرسون 

اي و يـا يكـي    رگـاه هـر دو رتبـه   اي بود از پيرسـون و ه  فاصلهنسبت هر وقت هر دو  .اي باشد فاصله

 .كنيم از اسپيرمن استفاده مي بوداي  رتبه

 .باشد مي 1تا  -1بين  عددي باشد و گيري مي ضريب همبستگي فاقد واحد اندازه

يم بـين دو  يگـو  مـي  H1ود نـدارد و در فـرض   ج ـيم بين دو متغير همبستگي ويگو مي H0در فرض 

 .توان نوشت فه و دو طرفه ميمتغير رابطه وجود دارد كه به صورت يك طر

 -1 برابـر بـا   rيم همبستگي كامل و مستقيم و بر عكس اگر يگو گردد مي+ 1برابر با  rاگر 

باشد همبستگي نـاقص و   1تا  0بين  rباشد اگر ميزان  گردد همبستگي كامل و معكوس مي

بـر بـا   برا rهرگاه  .باشد همبستگي ناقص و معكوس است 0تا  -1مستقيم است و اگر بين 

برقرار باشد در بايد در همبستگي پيرسون فرض نرمال بودن  .صفر گردد همبستگي وجود ندارد

خواهيم ارتباط بين دو متغير سـن و   به عنوان مثال مي .رويم ها مي غير اينصورت به سراغ ناپارامتري

 :براي انجام اين آزمون مراحل زير را دنبال كنيد .را تعيين كنيم BMIميزان 
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Analyze>Correlate>Bivariate 

 
ببريـد و مربـع    Variablesدو متغير را به جعبـه   .گردد با اجراي فرمان فوق صفحه زير نمايان مي

Pearson را تيك بزنيد. 

 
 :گردد خروجي ما به صورت زير نمايان مي okبا زدن 
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دار  متغيـر فـوق معنـي   باشـد و رابطـه دو    بسيار كم مي rبينيم كه ميزان  با توجه به خروجي بالا مي

 :همبستگي مراحل زير را دنبال كنيدبراي رسم نمودار  .نيست

Analyze>Regression>Curve Estimation 

 
 .گردد نمودار زير نمايان مي ،Okو زدن  با اجراي فرمان فوق و وارد نمودن دو متغير مورد نظر

 rميزان 

 دار بودن سطح معني
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ها نسبت بـه سـايرين    رخي از دادهتوان ديد كه ب شده است براحتي مي رسما جدر اين رگرسيونخط 

 :نمودار به روش زير است راه ديگر براي رسم .در وضعيت پرت قرار دارند

Graphs>Legacy Dialogs>Scatter, Dot 
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و در متغيـر وابسـته     Yبـراي محـور    Y Axis جعبـه متغيرها در از ليست پس از اجراي فرمان فوق 

 .كليك نماييد Okو روي  .وارد كنيدمتغير مستقل را  Xبراي محور  X Axis جعبه

 
 :باشد خروجي به صورت زير مي
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 رگرسيون خطي ساده

تـوانيم پـيش بينـي     در اين آزمـون مـا مـي   . در رگرسيون خطي ساده هر دو متغير بايد كمي باشند

 براي انجام آزمون مسـير . مقادير متغير وابسته را به ازاء مقادير مشخص متغير مستقل داشته باشيم

                                                  Analyze>Regression>Linear :زير را دنبال كنيد

 
 جعبـه و متغيـر مسـتقل را در    Dependent جعبـه پس از اجراي فرمان فوق، متغير وابسـته را در  

Independent  كنيد و روي واردOk كليك نماييد. 

 
 :خروجي به صورت زير است

 26اگر همبستگي بين . باشد صدم باشد همبستگي بسيار ضعيف يا فاقد ارتباط خطي مي 25تا  0اگر همبستگي بين 

صـدم باشـد، همبسـتگي در حـد متوسـط و       59تـا   40صدم باشد، همبستگي ضعيف اگر همبستگي بـين   39تا 

 باشد صدم بسيار قوي مي 86صدم باشد همبستگي قوي و همبستگي بالاتر از  85تا  60اگرهمبستگي بين 
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در اين خروجي . و معني دار نمي باشد  است بسيار كم rبينيم كه ميزان  وجه به خروجي بالا ميبا ت

مي توانيم به  )معادله خط رگرسيون( ارائه مي گردد كه با گذاشتن آنها در فرمول زير bو   aميزان 

 .را محاسبه كنيم yميزان  x مختلف ازاء مقادير

كه در دامنه مقادير متغير مستقل قـرار داشـته    را قرار دهيدعدد دلبخواه   xشما مي توانيد به جاي

و بـا اسـتفاده از دو مقـدار     را وارد مي كنـيم سـپس   20و بار دوم عدد  10مثلاً يك بار عدد  باشند

 .خط رگرسيون را رسم كنيد ،yبراي  بدست آمده

 همبستگي اسپيرمن

تعـداد  هرگـاه  . داد نمونـه كـم باشـد   و يا تعها نرمال نباشد  همبستگي اسپيرمن وقتي است كه داده

بـا فـرض نرمـال نبـودن      .كنـيم  اسپيرمن استفاده ميآزمون همبستگي از  گرديد، 15 كمتر ازنمونه 

 :كنيم اسپيرمن در همان مسير استفاده ميآزمون همبستگي از  ،ها در مثال قبل داده

bxay +=

 rميزان 

 سطح معني دار بودن 

 aميزان 

 bميزان 
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Analyze>Correlate>Bivariate 

 .را تيك بزنيد Spearmanببريد و مربع  Variablesمتغيرهاي موردنظر را به جعبه 

 
 :خروجي به صورت زير است Okزدن پس از 

 
 

 

 

اي باشد و يا يكـي   اگر هر دو متغير رتبه. اگر هردو متغير كمي باشد از همبستگي پيرسون استفاده كنيد
 .اي باشد از آزمون اسپيرمن استفاده كنيد از آنها رتبه

 –كرامـر  –فـي  -شد از تـاوي كنـدال  اي باشند و ميزان سطوح آن كم با اگر هر دو متغير اسمي و يا رتبه
 .استفاده كنيد Odds Ratioخطر نسبي و  -سامرز

 سطح معني دار بودن
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ratio odd 

اسـتفاده   Odds Ratioاز  يشـاهد  -گروهي از خطر نسـبي و در مطالعـات مـورد    در مطالعات هم

 ..يمكن به دو گروه مواجهه يافته و بدون مواجهه تقسيم مي در اين مطالعات افراد را  .كنيم مي

از ايـن تعـداد    از سگ منتقل مي شود مورد بررسي قرار گرفتـه انـد   كه    Xنفر براي بيماري  455

 ـبـا سـگ در تمـاس    نفـر   80.ندارند و با سگ هم در تماس نبوده اندنفر بيماري  100  ي بـدون  ول

و  نفر هم داراي بيماري هسـتند  250بيمار ولي بدون تماس با سگ و  نفر 25. . مي باشندبيماري 

 .براي شروع كار داده هاي خود را به صورت زير وارد مي كنيم  هم با سگ در تماس بوده اند

 
 

 

 

 

 

 سپس با استفاده از مسير زير داده ها را بر اساس متغير اصلي ما كـه در اينجـا بيمـاري مـي باشـد     

 Data >Weight cases .                                                          مي دهيم  وزن 
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 پس از مرحله فوق مسير زير را دنبال كنيد 

Analyze>Descriptive Statistics>Crosstabs 

 
 . گردد پنجره زير نمايان مي statisticsبا زدن دكمه 

 
خروجي ما به صورت زير نمايـان  ادامه دهيد Continueبا زدن دكمه . را علامت بزنيد Riskمربع 

 مي گردد 
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 . در جدول زير نمايان مي گردد  Odds Ratioميزان 

 
ابر افرادي است كه بيمـار  بر 12,5 خطر بيماري در افراد بيمار كه با سگ در تماس بوده اندميزان 

 .بوده اندمي باشند ولي با سگ در تماس ن

جدول مختصات مربوط به بيماري 
 و تماس با منبع بيماري

سطح معنی 
 دار بودن 

 ميزان
 Odds Ratio 
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 نمونه هايي از مطالعات انجام شده: فصل دوم

 ف برخي از مفاهيم يبه همراه تعر ي از مطالعات مختلف در ايرانيمثالها

 گرفته است بر اساس روشهاي مختلف آماري انجام محقق كه در اين فصل يك سري از تحقيقات 

در پايان فصل يك سري از مفاهيم  كه در ارتباط با آمار و روش تحقيق  . به عنوان مثال آورده ايم

 .است آورده شده است 

 :و آلفا كرونباخ  تي تست بر اساس مطالعات انجام شده 

پاييز ، )52شماره پياپي ( 3 ، شماره13 سال، مجله علمي پژوهشي دانشگاه علوم پزشكي اراك

1389 ،7-1 

  ، نادر عاليشان عليرضا شهاب جهانلو، عليرضا سبحاني

نامه استاندارد كيفيت زندگي در ارزيابي ارتباط وجوه شخصيتي و نحوه  مقايسه دو پرسش

 ران ديابتيككنترل قند در بيما

 :چكيده

هاي پزشكي  هاي اخير، كيفيت زندگي به عنوان يك مفهوم مهم در پژوهش در دهه :زمينه و هدف

نامه استاندارد كيفيت زندگي براي ارزيابي وجوه شخصيتي بيماران  دو پرسش. مطرح گرديده است

نامه ايراني  سشنامه مربوط به سازمان بهداشت جهاني و ديگري پر نخستين پرسش. انتخاب شدند

نامه از  هدف اصلي اين مطالعه، مقايسه دو پرسش. باشد سنجش كيفيت زندگي بيماران ديابتيك مي

 .باشد نظر ارزيابي ارتباط وجوه شخصيتي و نحوه كنترل قند در بيماران مبتلا به ديابت مي

ابقه بيش از يك بيمار ديابت نوع دو با س 256اين بررسي تحليلي مقطعي بر روي  :ها مواد و روش

شخص  روايي و پايايي هر دو پرسش. سال بيماري انجام گرفت نامه در مطالعات قبلي م

كي از ويژگي. گرديده بود دازه گيري  با اين وجود به دليل اين كه پايايي ي زار ان هاي فني اب
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زارهاي گردآوري اطلاعات كرديم مي م به سنجش پايايي اب جهت انجام اين امر . باشداقدا

ع بررسي تعداد در  كميل گرديد،  پرسش 38شرو ك توزيع و ت نامه در بين بيماران ديابتي

خ آلفاكرونبا آزمون  ستفاده از  آلفا  (Alpha Chronbach)سپس با ا م به تعيين ضريب  اقدا

راي پرسش آمده ميزان اين ضريب را در پرسش. ها نموديم نامه ب ج به دست  نامه  نتاي

IRDQOL  ر با راب ر با  WHOQOLنامه  سشو در پر 862/0ب راب شان داد كه  877/0ب ن

سي هموگلوبين. باشد قابل قبول مي آمارها با . به روش كالري متري سنجيده شد اوان

ك طرفه  مورد بررسي قرار گرفتند آناليز واريانس ي آزمون تي،  ستفاده از   ا

دار كمتر از  طور معنيايراني كيفيت زندگي به نامه  ميانگين امتياز بعد جسماني در پرسش :ها يافته

همبستگي . نامه ديده نشد بين ساير ابعاد دو پرسش داري ما تفاوت معني. نامه ديگر است پرسش

همبستگي . نامه ديده شد پرسشهمان با ساير ابعاد نامه  هر پرسش مثبت بين بعدهاي مختلف

همبستگي . جود داردنامه و نامه و كيفيت زندگي مربوط به همان پرسش بالايي بين ابعاد هر پرسش

 . نامه ديده نشد بين كنترل قند و ابعاد مختلف كيفيت زندگي در هر دو پرسش

نامه براي كل كيفيت زندگي وجود دارد ولي نحوه توزيع  پايايي در هر دو پرسش: نتيجه گيري

كيفيت ارزيابي وجوه شخصيتي بيماران، . نامه ايراني كيفيت زندگي همگن نيست سوالات در پرسش

هيچ كدام از دو . باشد نامه سازمان بهداشت جهاني مي نامه كمتر از پرسش توسط اين پرسش

 .نامه ارتباطي را ما بين وجوه شخصيتي بيماران و كنترل قند نشان ندادند پرسش

 ، كيفيت زندگي اوانسيديابت، هموگلوبين  :واژگان كليدي
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 آناليز واريانس يك طرفه مطالعه بر اساس آزمون 

همزمان با  89پذيرش مقاله در شهريورماه هرمزگان،  ه علمي پژوهشي دانشگاه علوم پزشكيمجل
 چاپ اول كتاب 

 عليرضا شهاب جهانلو، ، عليرضا سبحاني 

بررسي ريسك فاكتورهاي قلبي در بيماران ديابتيك بر اساس سطح سواد، دانش و آگاهي 

 و رفتار مرتبط با بيماري ديابت

 : چكيده

لبي و عروقي از عوارض اصلي بيماري ديابت مي باشند كه باعث مرگ زودرس در اين بيماريهاي ق

شيوع بيماري هاي قلبي و عروقي را مي توان با كاهش فشار خون ، چربيهاي . بيماران مي شود 

هدف اين مطالعه بررسي ريسك فاكتورهاي قلبي و عروقي بر اساس . سرم و كنترل قند كاهش داد

،  HbA1cبراي رسيدن به اين هدف اقدام به اندازه گيري . ديابتيك مي باشد سطح سواد بيماران

براي نتيجه گيري دقيقتر ميزان . چربيهاي سرم ، شاخص توده بدني و فشار خون بيماران نموديم

 . دانش و آگاهي مرتبط با بيماري ديابت و رفتار مرتبط با اين بيماري نيز مورد سنجش قرار گرفت

به درمانگاه  86-87بيمار ديابتيك كه طي سالهاي  256ين بررسي مقطعي بر روي ا –روش و متد 

بيماران به دو گروه بيسواد و كم سواد . ديابت شهر بندرعباس مراجعه كرده بودند، انجام گرفت 

به  HbA1cبه روش آنزيماتيك و  HDLو  LDL كلسترول ، تري گليسيريد. دسته بندي شدند 

فشار خون بيماران و شاخص توده بدني به روش استاندار بدست . ده شدروش كالري متريك سنجي

بوسيله دو پرسشنامه استاندار ، دانش و آگاهي مرتبط با بيماري ديابت و رفتار مرتبط با اين .آمد

آناليز داده ها بوسيله آناليز واريانس يك طرفه و همبستگي بين متغير وابسته . بيماري سنجيده شد

 . ق آزمون آناليز همبستگي محاسبه گرديدو مستقل از طري
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ميانگين . درصد بيماران داراي اضافه وزن مي باشند 73از كل بيماران بيسواد و % 52–نتايج 

در  LDLميزان . شاخص توده بدني و تري گليسيريد در خانمها بيشتر از آقايان و معني دار است

وجود اينكه ميزان دانش و آگاهي مرتبط با با . افراد بيسواد بيشتر از كم سواد و معني دار است

ديابت و ميزان عملكرد مربوط به اين بيماري در گروه بيسواد پائينتر از گروه كم سواد مي باشد ولي 

 . از نظر سطح كنترل قند خون بين دو گروه اختلاف معني داري ديده نشد

كتورهاي قلبي در بيماران با توجه به بالاتر بودن شاخصهاي مربوط به ريسك فا –نتيجه گيري 

بيسواد نسبت به ساير گروهها ، پيشنهاد مي گردد كه آموزشهاي لازمه در قالب يك الگوي آموزشي 

 . دقيق به تفكيك بيسواد و كم سواد جهت بيماران ارائه گردد

 ، سطح سواد ، چربيهاي خون  HbA1c –كلمات كليدي 

. 
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 ضريب همبستگي پيرسون مطالعه بر اساس 

همزمان با چاپ  89، ، پذيرش مقاله در شهريورماه ه علمي پژوهشي دانشگاه علوم پزشكي اراكمجل
 اول كتاب 

 دكتر احمد نگهي، هادي سرافراز، دكتر عليرضا شهاب جهانلو 

 تاثير محل فيستول شرياني وريدي در بروز سندرم تونل كارپ در افراد همودياليزي

 چكيده 

در  ،دستيابي به عروق براي سريع  آسان ويك روش وريدي  –فيستول هاي شرياني : مقدمه 

عصب بيماران همودياليز است، از عوارض مهم آن عدم خون رساني به اعصاب اندام ها از جمله 

در بروز  تاثير محل فيستول شرياني وريديبا هدف مطالعه اين . مي باشدمچ دست در مديان 

 .انجام گرفتسندرم تونل كارپ 

 روش كار

بيمار همودياليزي بيمارستان شهيد محمدي بندرعباس در سال  37مطالعه مقطعي برروي اين 

كليه بيماران داراي يك فيستول ديستال يا پروگزيمال فقط در يك دست . انجام گرفت 86-87

، جهت )زمان تاخيري ديستال حسي وحركتي عصب مديان(از روش  سرعت هدايت عصبي . بودند

اندام فاقد فيستول به عنوان شاهد در مقابل اندام . استفاده گرديد تشخيص سندرم تونل كارپ

، براي تعيين ضريب   t- testجهت مقايسه داده هاي كمي از آزمون . داراي فيستول قرار گرفت

 همبستگي بين متغير هاي وابسته و مستقل از ضريب همبستگي پيرسون استفاده گرديد

   نتايج  

طول عمر فيستول  .فيستول ديستال داشتندمابقي فيستول پروگزيمال و نفر از بيماران داراي  17

دار و اندام فيستول در مچ دست  25. مشخص شدنفر كمتر از يكسال  22نفر بيشتر از يكسال و 15

 .سندرم تونل كارپ مبتلا بودندفيستول به مچ در اندام فاقد  27



 بهداشت علوم پزشکی و راهنمای گام به گام در تحقيقات  

 

 

139 

ديان در اندام فيستول دار با اندام زمان تاخيري ديستال حسي عصب متفاوت معني داري مابين  

يك ارتباط . بين ساير متغير هاي مورد بررسي تفاوت معني داري ديده نشد. ديده شدفيستول  فاقد

 .تغييرات سرعت هدايت عصبي بدست آمد و مدت همودياليز/ طول عمر فيستولمعني دار ابين 

 نتيجه گيري 

دار وبدون فيستول يكسان است وتفاوتي از لحاظ  در هر دو اندام فيستول سندرم تونل كارپ بروز 

 .سكيميك عصب مديان وجود ندارديا يمحل فيستول وتاثير آن در ايجاد نورپات

 سندرم تونل كارپ  -فيستول  -همودياليز :كليد واژه ها
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تي استيودنتهمبستگي اسپيرمن و مطالعه بر اساس آزمونهاي   

Acta Medica Iranica Acceptable in Apr 2010 

Alireza Shahab Jahanlou , Nader Alishan Karami,  

WHO Quality of Life-BREF 26 Questionnaire: Reliability And 
Validity of the Persian Version and compare it with Iranian Diabetics 
Quality of Life Questionnaire in Diabetic Patients 
 
Abstract  

There are several tools for the assessment of quality of life (QOL) in 

diabetes mellitus. In the current research, two standard questionnaires for 

evaluating of QOL were selected. First one was a questionnaire from The 

World Health Organization Quality of Life (WHOQOL-BREF 26) and 

the second one, The Iranian Diabetics Quality of Life (IRDQOL). The 

first aim of this study was to reliability and validity of the Persian 

Version of WHOQOL-BREF 26. The second aims compare it with 

IRDQOL Questionnaire in Diabetic Patients.  

 A random sample of Iranian adult outpatient diabetics (n=387) was 

selected and they completed the WHOQOL and IRDQOL assessment 

instruments. In addition HbA1c was measured in these patients by 

calorimetric method. Data analysis was carried out by the use of T-test, 

Spearman correlation coefficient, Pearson’s correlation coefficient.  

Data analysis based on Pearson correlations in the two questionnaires 

showed all subscales and total QOL have highly acceptable test-retest 

reliability. Comparison of Total QOL and similar domains in the two 

questionnaires showed physical domain score in IRDQOL was lower than 

in WHOQOL and it was significant(P<.0001). Total QOL is more highly 

correlated with social domain and environmental domain in IRDQOL and 
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WHOQOL, respectively. In IRDQOL, spiritual domain is not correlated 

with physical domain.  

Calculated parameters of reliability in the questionnaires indicated that 

stability present promising results in Total QOL. In this study, WHOQOL 

is more effective than IRDQOL to evaluate QOL. WHOQOL domains 

have a logical relationship between glycemic control and QOL, but this 

logical relationship can not be found in IRDQOL questionnaire. In 

IRDQOL spiritual domain is a very unreliable domain. We recommend 

more questions to be added spiritual domain in IRDQOL questionnaire 

and also distribution of items to be some how equal in four domains.  By 

these, it may help to find some rational relations between afore-

mentioned domains and glycemic control. 

Author Keywords: Quality of Life, HbA1c, Diabetics 
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 ويتني -مانآزمون مطالعه انجام شده بر اساس  

 260، 1386زمستان ، 4 ، شمارههرمزگان مجله علمي پژوهشي دانشگاه علوم پزشكي
 عليرضا شهاب جهانلو، ، عليرضا سبحاني 

 خون در بيمارانارتباط بين آگاهي، خودكارآمدي و كيفيت زندگي با كنترل قند و چربي 

 كننده دخانيات ديابتيك مصرف

سازمان بهداشت، كيفيت زندگي را به مفهوم درك برداشت هر فرد از موقعيت خود : مقدمه :مقدمه

 هدف اين مطالعـه بررسـي ارتبـاط   . زندگي با توجه به شرايط فرهنگي و اجتماعي دانسته است در

ديابـت   ون و چربي خون در افـراد مبـتلا بـه   آگاهي، خودكارآمدي و كيفيت زندگي با كنترل قند خ

مقطعي بوده و  اين مطالعه يك مطالعه: روش كار. باشد قندي، بر اساس مصرف دخانيات بيماران مي

مبـتلا بـه ديابـت نـوع      بيمار ۱۲۵ .در مدت سه ماه در كلينيك ديابت شهر بندرعباس انجام گرفت

سابقه بـيش از يكسـال مبـتلا بـه      ران دارايتمامي بيما. دوم به روش سرشماري وارد مطالعه شدند

پرسشــنامه اســتاندارد  ،WHOQOL BREF-26 پرسشــنامه كيفيــت زنــدگي. ديابــت بودنــد

. ديابتيك مورد استفاده قـرار گرفـت   خودكارآمدي و پرسشنامه استاندارد دانش و آگاهي در بيماران

 ميزان كلسترول تام، ميزانگليسريد،  تري ، ميزانLDL  ، ميزانHbA1c  در اين بيماران، ميزان

HDL افزار آوري بوسيله نرم جمع ها پس از كليه داده. ، سنجيده شده است SPSS 12   و اسـتفاده

ميـانگين دانـش و آگـاهي در بيمـاران     : نتـايج . تحليـل شـد   ويتني تجزيه و و آزمون من t-test از

گي بيماران سـيگاري كمتـر   سطح كيفيت زند. دار بود غيرسيگاري و معني سيگاري كمتر از بيماران

ميـزان توانـايي تمركـز در بيمـاران سـيگاري كمتـر از       ) .>۰۱/۰P(دار بود  معني از غيرسيگاري و

 احساسات منفـي ماننـد غمگينـي، نگرانـي و افسـردگي در     ) .>۰۴/۰P(غيرسيگاري بود  بيماران

بـا وجـود   : گيري جهنتي) .>۰۵/۰P(كشيدند  بيماران سيگاري بيشتر از بيماراني بود كه سيگار نمي

هاي ذكر شده  اساس پرسشنامه اين كه در اين بررسي، تفاوت ميان بيماران ديابتيك غيرسيگاري بر

داري بـين افـراد    هيچگونه اخـتلاف معنـي   مشخص شد، ولي با مقايسه بين متغيرهاي آزمايشگاهي،
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مداخله آموزشـي   گردد كه يك بنابراين پيشنهاد مي .ديابتيك سيگاري و غيرسيگاري ملاحظه نشد

ــاهي     ــش و آگ ــطح دان ــردن س ــالا ب ــت ب ــرد    جه ــام گي ــيگاري انج ــك س ــاران ديابتي  .بيم
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 One Way ANOVA Post Hocمطالعه انجام شده بر اساس 

Acta Medica Iranica Acceptable in June 2010 

Alireza Shahab Jahanlou, Fazollah Ghofranipour  

The effect of literacy level on health related-quality of life, self-

efficacy and self-management behaviors in Diabetic Patients  

Abstract: 

Background-Illiteracy in studies on quality of life (QOL) and self-

efficacy (SE) of diabetic patients has been ignored. Illiteracy and diabetes 

have high rates in developing countries. 

Objective-The aim of this study was to identify the effect of literacy level 

on health outcomes. To achieve this, we studied health outcomes such as 

SE, self-management behaviors and health-related quality of life in 

diabetic patients. 

Methods-A cross-sectional study was carried out in an Iranian urban 

federally-funded diabetics’ clinic (have 1400 diabetes patients) in Bandar 

Abbas, a city located in south of Iran. 256 Non Insulin Dependent 

Diabetic Mellitus (NIDDM) patients were chosen during June, July and 

August 2007. Patients were grouped as illiterates, low-literates and 

literates. Self-efficacy and quality of life were measured by standard 

questionnaires. HbA1C was measured by calorimetric method. Data was 

collected wiyh interview. Data analysis was carried out with one way 

ANOVA Post Hoc, and bivariate analysis method. 

Results- Literacy level among the three groups from the view points of 

age, physical domain, psychological domain, environmental domain and 

self-efficacy were  significant. There was no significant difference in the 

level of HbA1C among three groups.  
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Conclusion- Literacy level does not have any effects on glycemic control 

and there is a strong relationship between self-efficacy and QOL 

domains.  

Abbreviations- WHOQOL; World Health Organization Quality of Life   - 

HRQOL; Health Related Quality of Life – SE; Self Efficacy     

Author Keywords: Quality of Life, WHOQOL-26, HbA1c, Diabetes 

mellitus type 2, literacy, Self Efficacy,    

http://ci.nii.ac.jp/search/servlet/Kensaku?dnum=25&sortType=year1&Text=&condition0=1&area0=allText&comb0=1&keyword0=%22WHOQOL-26%22&conditionRange0=1&areaRange0=year&KeyRangeS0=&KeyRangeE0=&select=&pnum=1&mode=0&sortType_bottom=&AREACNT=1&JNUM=1&RANGE_AREACNT=1&SORTFLG=DESC&SORTKEY=year1&SORTMARK=0&USELANG=en�
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آمار و روش تحقيق تعريف   برخي مفاهيم در 

عتبار پيش بين توانـد متغيرهـاي مـلاك     ميزاني كه يـك مقيـاس مـي    .(Predictive validity) ا

 .همچنين به تعريف اعتبار ملاك توجه كنيد. بيني كند مهم را پيش) بازده(

عتبار سازه  ميزاني كه يك مقياس يك وجه خاص يـا يـك سـازه مـورد     . (Construct validity)ا

 .سنجد علاقه را مي

عتبار محتوي ميزاني كه عبارات يك مقياس نمايانگر يك وجـه معـين يـا     .(Content validity) ا

 .موضوع مورد علاقه است

عتبار ملاك  ك مهمـي را  ميزاني كه يك مقياس قادر است متغيرهاي ملا .(Criterion validity)ا

 .همچنين به تعريف اعتبار پيش بين نگاه كنيد. بيني كند پيش

كننـد تـا آن را    سازه پنهـاني كـه ابزارهـا تـلاش مـي     . معادلي است براي سازه. (Dimension)بعد 

 .گيري كنند اندازه

هـاي مـلاك    يك روش آماري بـراي تفكيـك گـروه   . (Discriminant analysis) تحليل افتراقي

 .هاي يك يا چند مقياس ز قبل با استفاده از نمرهشكل گرفته ا

گيـري مبراسـت اطـلاق     هاي يك آزمون از خطاي انـدازه  به ميزاني كه نمره .(Reliability)پايايي 

 .گردد مي

ري كـه عينـي و قابـل مشـاهده نيسـت بلكـه انتزاعـي و پنهـان اسـت           .(Construct)سازه  . متغيـ

ها متغيري عينـي   مه قابل مشاهده است و جمع اين پاسخهاي آزمودني به عبارات يك پرسشنا پاسخ

شود عبـارات مـذكور پـس از جمـع      اما به مفاهيمي كه فرض مي. آورد يا قابل مشاهده را بوجود مي

 .شود سازه گفته مي...) مانند شدت درد، اختلال درد و (سنجد  شدن با يكديگر آنها را مي
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هـا   شود كه عامـل  فرض مي معمولاً. شود مل پديدار ميآنچه كه به سيله تحليل عا .(Factor)عامل 

آن گروه از فرآيند زير بنايي را كه باعث ايجاد همبستگي بين عبارات وارد شده به يك تحليل عامل 

عبـارت اسـت و    11اي كه داراي  به عنوان مثال از تحليل عامل پرسشنامه. كند هستند، منعكس مي

ت به ميـزان اخـتلال ناشـي از درد اختصـاص دارد دو عامـل      عبار 7عبارت از آن به شدت درد و  4

عبارتي كه با تعيين  7عبارتي كه با شدت درد مرتبط هستند اولين عامل و  4. استخراج خواهد شد

در اين مثال اولين عامـل  . آورند ميزان اختلال ناشي از درد مرتبط هستند دومين عامل را بوجود مي

 .دومين عامل را مرتبط با اختلال ناشي از درد تفسير كرد توان مرتبط با شدت درد و را مي

محتوي مفروضي كه مقياس مورد نظر براي ارزيابي آن طراحي شـده   .(Domain)قلمرو يا حيطه 

براي مثال اگر مقياسي براي ارزيابي وجه حسي درد نوروپاتيك بوجود آمده اسـت، قلمـرو يـا    . است

 .همراه با درد نوروپاتيك است حيطه مورد نظر شامل تمام حسيات ممكن

گروه هاي خاصي از افراد كه در يك يا چند متغير ملاك . (Criterion groups)گروه هاي ملاك 

موضوع مهم در اينجا . از يكديگر متفاوت هستند و از آنها براي تعيين اعتبار ملاك استفاده مي شود

ا تفكيـك قائـل گـردد و يـا افـراد را بطـور       ميزاني است كه ابزار اندازه گيري مي تواند بين گروه ه ـ

 .صحيحي در گروه ها قرار دهد

روشي است براي تعيين تعداد عوامـل بدسـت آمـده از تحليـل      . (Kaiser criterion)ملاك كيزر

بر اساس ملاك كيزر، تعداد عوامل برابر اسـت بـا تعـداد    . هاي ويژه قرار دارد عامل و بر مبناي ارزش

 .از يك هاي ويژه بزرگتر ارزش

شـود كـه    در هر سنجش به آن بخش از واريانسـي گفتـه مـي   . (Error variance) واريانس خطا

 .همراه يا ناشي از بعد خاصي كه ابزار سنجش براي آن طراحي شده است، نيست

 



 بهداشت علوم پزشکی و راهنمای گام به گام در تحقيقات  

 

 

148 

كـه از تحليـل افتراقـي    (نمره ناشي از يك عمـل افتـراق    . (Discriminant score)نمره افتراقي

 .شود هاي ملاك استفاده مي آن براي قرار دادن افراد جديد در يكي از گروه و از) آيد بدست مي

ساني دروني  بـه عنـوان    هاي پايـايي اسـت و غالبـاً    يكي از مقياس. (Internal consistency)هم

آلفاي كرونباخ نمايانگر آن است كه به چه خوبي و تناسـبي گروهـي   . گردد آلفاي كرونباخ برآورد مي

 .كنند گيري مي يا سازه زير بنايي را اندازهاز عبارات بعد 

مفاهيم و مولفه هاي اعتبار و پايايي، چگونگي تعيين اين مفاهيم و مولفه : 1جدول شماره 

گيري در مورد انتخاب يك ابزار سنجش بايد -ها و پرسش هايي كه به هنگام تصميم

 مطرح گردد

 تفسير و پرسش ن و ارزيابيييچگونگي تع مفهوم
گيـري درد بـه اعتبـار محتـوي      هاي اندازه در ساختن مقياس قضاوت افراد ماهر محتوياعتبار 

 گردد آنطور كه شايسته است توجه نمي
توان گفت مقياس مـورد   شواهدي كه بر پايه آن مي: پرسش

 سنجد كدامند؟ بحث عامل يا بعد مورد نظر را مي
هـاي   همبستگي بـا سـاير مقيـاس    اعتبار سازه

ســـازه را معتبـــري كـــه همـــان 
ســنجد، همبســتگي بــا ســاير  مــي

هـاي   هاي معتبري كه سازه مقياس
ــي ــاوتي را م ــل  متف ــنجد، تحلي س

 .هاي اصلي عامل و تحليل مولفه

هاي معتبري كه همان  مقياس مورد نظر بايد با ساير مقياس
هـاي   سنجد داراي همبستگي قـوي و بـا مقيـاس    سازه را مي

داراي همبستگي  سنجد هاي متفاوتي را مي معتبري كه سازه
هـاي   در تحليل عامل و تحليل مولفه. ضعيف تا متوسط باشد

اصلي عبارات يك مقياس بايد برروي يك عامل يا يك مولفه 
 .قرار گيرد

اگـر مقيـاس مـورد بحـث واقعـا آنچـه را كـه بـراي         : پرسش
سنجد آيـا الگـوي ارتبـاط     سنجش آن طراحي شده است مي

ها در همان جهت مورد  بين مقياس مورد نظر و ساير مقياس
 انتظار است؟

گيري كه عبارات  آيا نتايج تحليل عامل از اين نتيجه: پرسش
كنـد   گيـري مـي   موجود در مقياس تنها يـك سـازه را انـدازه   

 كند؟ حمايت مي
اي كـه   توانايي انجام كار يا وظيفـه  اعتبار ملاك

 ابزار براي آن طراحي شده است
ي را كه براي انجام آن طراحـي  ا ابزار بايد قادر باشد تا وظيفه

 .شده است انجام دهد
شـواهدي كـه از كـاربرد اختصاصـي ابـزار حمايـت       : پرسش

 كند كدام است؟ مي
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همساني دروني ميزان همبسـتگي عبـارات موجـود در يـك      همساني دروني پايايي
 .كند پرسشنامه با يكديگر را منعكس مي

اي كـه   مونـه اي شبيه به ن در مطالعات قبلي با نمونه: پرسش
قرار است مقياس در آن بكار گرفته شـود، ضـريب همسـاني    

 دروني عبارات مقياس مورد نظر چقدر بوده است؟
هاي يك مقيـاس   پايايي بازآزمايي به ميزان ارتباط بين نمره پايايي بازآزمايي پايايي

گيـري بـا حفـظ فاصـله زمـاني معينـي اطـلاق         در دو اندازه
 .گردد مي

به (گيري  بر اين است كه عامل مورد اندازهاگر تصور : پرسش
داراي ثبات است آيا شواهد موجـود  ) عنوان مثال شدت درد

 كند؟ از پايايي بازآزمايي حمايت مي
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